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Introduction

Thank you very much for your purchase of this Toshiba pocket personal
computer.

Please be sure to read this user’s manual before using the Toshiba
Pocket PC, and ensure that you are aware of the correct handling
procedures.

B Please be sure to read the “Safety precautions” section in this
document to learn about important safety issues.

B After reading this document, keep it in a convenient place for future
reference.

Copyright Information

© 2002 by Toshiba Corporation. All rights reserved. Under the copyright
laws, this manual cannot be reproduced in any form without the prior
written permission of Toshiba. No patent liability is assumed, with respect
to the use of the information contained herein.

TOSHIBA Pocket PC e310 User’s Manual

First edition March 2002

Trademarks

User's Manual

Microsoft, ActiveSync, Outlook, Pocket Outlook, Windows, Windows NT,
and the Windows logo are either registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.
Microsoft products are licensed to OEMs by Microsoft Licensing, Inc., a
wholly owned subsidiary of Microsoft Corporation.
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Safety precautions

B Please carefully read “Safety precautions” before using the Toshiba
Pocket PC and ensure that you are aware of correct handling
procedures.

B The precautions provide essential information for the protection of the
user and others from possible injury and property damage. They also
provide information on the safe handling of this product .

B Please check that you fully understand the definition of the following
messages (signs and graphical symbols) before reading the text, and
always follow the instructions provided.

Supplementary Information: “The product complies with the requirements of the Low Voltage
Directive 73/23/EEC and the EMC Directive 89/336/EEC.”

Weitere Informationen: “Das Produkt entspricht den Anforderungender Niederspannungs
Richtlinie 73 23/EG und der EMCRichtlinie 89/336/EG.”

Informations complérnentaires: “Ce produit est conforme aux exigences de la directive sur
les basses tensions 73/23/CEE et de la directive EMC 89/336/CEE.”

Informacién complementaria: “El Producto cumple los requistos de baja tension de la
Directiva 73/ 23/CEE vy la Directiva EMC 89/336/CEE.”

Ulteriori informazioni: “Il prodotto é conforme ai requisiti della direttiva sulla bassa tensione
73/23/EG e la direttiva EMC 89/336/EG.”

Ytteligare information: “Produkten uppfyller kraven enligt lagspanningsdirektiver 73/23/EEC
och EMC-direktiv 89/336/EEC.”

Explanation of signs

Signal icons for WARNING, CAUTION, and NOTE, will be followed by
important safety information that must be carefully reviewed.

Icon Meaning

WARNING

Indicates a potentially hazardous situation, which
could result in death or serious injury (") if you do
not follow instructions.

Q CAUTION
Indicates a potentially hazardous situation, which
if not avoided, can result in minor injury (?) or
property damage (®).

O NOTE
l' Gives you helpful information.

*1: Serious injury corresponds to an injury that leaves some aftereffect, and requires hospital
treatment or long term treatment as an outpatient such as blindness, injuries, burns (high
temperature, low temperature), electric shock, fractures, poisoning, etc.

*2: Minor injury corresponds to an injury that does not require hospital treatment or long term
treatment as an outpatient, that is to say, injuries, burns, electric shock, etc.

*3: Property damage corresponds to the extensive damage with regard to the house
structure, household goods, livestock, pets, etc.
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Limitation of liability

Toshiba Corporation is in no way liable for any damage resulting from
earthquakes, fire, actions on the part of a third party, other accidents
beyond the control of Toshiba Corporation or intentional acts,
negligence or misuse on the part of the user or any usage under
abnormal conditions.

Toshiba Corporation is in no way liable for any damage, including but
not limited to change or loss of stored data, loss of business profit,
lost profits, interruption of business, or lost communication
opportunities that are caused by usage or non-usability of this
product.

Toshiba Corporation is in no way liable for any damage resulting from
failure to comply with the contents of this instruction manual.

Toshiba Corporation is in no way liable for any damage resulting from
malfunction due to usage in combination with connection devices,
software, or devices other than those provided by Toshiba
Corporation with the product.

Handling the unit (including the built-in batteries)

WARNINGS

User's Manual

Turn the power off in areas where usage is prohibited, such as
onboard aircraft or in a hospital and do not use the pocket PC.

Usage in such areas can cause an accident due to negative effects on
equipment such as aviation equipment onboard or medical
equipment.

Keep the pocket PC no less than 22 cm away from persons with a
heart pacemaker implant when using the device in combination with a
mobile phone.

Failure to maintain this distance can cause an accident due to
negative effects on the pacemaker at close proximity.

Do not use the pocket PC when driving a car, etc. or while walking.

Usage when driving a car or while walking can cause a traffic accident
or injury.

Do not allow metallic objects, such as staples and clips, to enter
inside the pocket PC.

Do not connect the terminals (metallic parts) with metallic objects.

Entry of or contact with foreign objects can cause heat generation or
ignition.
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B If the pocket PC emits an unusual smell or sound, or generates
smoke, turn the battery switch to the off position immediately and
disconnect the AC adaptor from the power outlet.

Continued use of the pocket PC under any of these conditions can
cause fire.

Please contact the dealer from whom the pocket PC was purchased
and request inspection or repair service.

B Do not use or store in the following locations.

Locations such as a bathroom where the pocket PC can be
subjected to water splashes or conditions of high humidity.

Locations where rain, fog, etc. can enter directly.

Locations subject to high temperatures, such as near to a fire or
heating equipment.

Locations exposed to direct sunlight.
Inside a tightly closed car under hot sunlight.
The built-in battery can suffer liquid leakage, ignition, or rupture.

B Do not drop the pocket PC or allow the pocket PC to be subjected to
any severe shock.

The built-in battery can suffer liquid leakage, ignition, or rupture.

M If the built-in battery leaks liquid, or emits an unusual smell, remove it
immediately from the vicinity of any source of fire.

Continued use of the pocket PC under any of these conditions can
cause ignition of the leaked liquid, or rupture.

M If liquid leaks from the built-in battery, do not touch it.

If such liquid is allowed to come into contact with the skin, it can
cause eye or skin injuries. If the liquid should enter the eyes, irrigate
the eyes thoroughly with clean water and immediately seek medical
attention. If the liquid should come into contact with the skin or
clothing, wash it away immediately with clean water.

B Do not disassemble, remodel or repair.
Disassembly, remodeling, or repair can cause injury.

Please contact the dealer from whom the pocket PC was purchased
and request repair service.
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CAUTIONS

When using the pocket PC with the earphone (sold separately)
connected to it, do not raise the sound volume level too high.

Raising the sound to high volume levels can impair your hearing
ability.

If the display is broken, and the liquid crystal (liquid) leaks out, do not
touch it.

In the event of contact with the skin, the liquid crystal can cause a
rash on the skin. If the liquid crystal should come into contact with the
skin or clothing, wash it off immediately with clean water.

Keep the pocket PC out of the reach of infants.
Placing within the reach of infants can cause injury.

Handling AC adaptor, power cord, cradle

WARNINGS

User's Manual

Use only the AC adaptor supplied with the pocket PC.

Using an AC adaptor other than that supplied can cause smoke or
ignition.

Insert the power plug to a household electric outlet.

When travelling abroad, never plug the AC Adapter into a power
source that does not correspond to both the voltage and the
frequency specified on the rating plate of the unit, as equipment
damage will result.

Do not connect or disconnect the power plug with wet hands.

Connecting or disconnecting under these conditions can cause
electric shock.

Do not leave open containers filled with liquid, such as cups, near the
AC adaptor.

Spilt liquid entering the pocket PC can cause ignition or electric
shock.

Do not use the pocket PC in locations, such as a bathroom, where it
will be subjected to liquid splashes.

Exposure to liquid can cause ignition or electric shock.

If dust is found on or around the pins of the power plug, turn off the
pocket PC and disconnect the power plug from the outlet, then wipe
off the dust using a dry cloth.

Dust accumulation on the power plug can cause fire due to loss of
insulation.

Vi
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B Do not disassemble, remodel, or repair.
Disassembly, remodeling, or repair can cause fire, electric shock, or
injury.
Please contact the dealer from whom the pocket PC was purchased
and request repair service.

CAUTIONS
B When unplugging the power plug from the outlet, disconnect the
power cord by grasping the power plug itself.

Pulling out the power cord by grasping the cable can cause ignition or
electric shock due to cable damage.

B When handling the power cord, observe the following rules.
Do not damage the power cord.
Do not tamper with the power cord.
Do not twist the power cord.
Do not forcibly bend the power cord.
Do not pull the power cord.
Do not overload the power cord.
Do not heat the power cord.
Do not place it close to heating apparatus.
Failure to do so can cause fire or electric shock.

If you find that the power cord is damaged, please call the dealer from
whom the pocket PC was purchased and purchase a new power
cord.

B Do not connect terminals (metallic parts) with metallic objects, such as
wires.

Connecting the terminals (metallic parts) with metallic objects can
cause heat generation or burns.

B Keep the pocket PC out of the reach of infants.
Placing within the reach of infants can cause injury.

NOTES
B Use the pocket PC only in locations with the following ambient
environmental conditions.
When operatingTemperature 0°C to 40°C, Humidity 30% to 80%
When charging Temperature 5°C to 35°C
B Do not use or store the Pocket PC in the following locations.
Locations subject to extremely high or low temperatures
Dusty locations
Locations subject to strong vibration

Usage or storage in such locations can cause failure, malfunction, or
loss of stored data.
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B Do not allow the Pocket PC to be subjected to sharp temperature
changes.

The resulting moisture condensation can cause failure, malfunction, or
loss of stored data.

If moisture condensation is generated, use the Pocket PC only after
allowing it to dry completely.

B When charging the battery, the case of the AC adaptor can become
warm, but this is not abnormal.

B Disconnect the power plug from the outlet when not in use.

B Avoid inadvertently sitting while the Pocket PC is inserted in the back
pocket of trousers, etc.

Sitting under these circumstances can cause damage or failure.
B Do not place objects or drop them on top of the Pocket PC.

When the pocket PC is placed in a bag containing heavy items, do not
allow it to be caught underneath them.

Placing it under these conditions can cause damage or failure.
B Clean the terminals (metallic parts) occasionally with a Q-tip.
Dirty terminals can cause disconnection or poor charging.

B Do not use organic solvents such as benzene or thinner to clean the
Pocket PC.

Use of these solvents can cause deformation or discoloration.
Wipe dirty parts with a soft dry cloth.

B Do not wipe the display with a wet cloth. Do not touch it with wet
hands.

Wiping or touching under these conditions can cause failure or
malfunction.

Wipe the display with a soft dry cloth.

B It is recommended that important data stored in the unit should be
either noted down occasionally, or saved to a memory card (sold
separately) or personal computer (data transfer with Active Sync).

The following can result in loss of stored data.
Misuse of the Pocket PC

Subjecting the main unit to the effects of static electricity or
electric noise

Total loss of charge in the built-in battery due to an extended
period of non-use

Failure or repair servicing of the Pocket PC

B Toshiba Corporation is in no way liable for change or loss of stored
data resulting from failure or repair of the unit. Please understand this
before usage.
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B When using the optional (sold separately) “SD memory card”, please
be sure to read the relevant instruction manual and ensure that you
are aware of correct handling procedures.

Do not allow the card to be subjected to any severe shock while
connected to the unit. Such shocks can cause damage or failure.

Do not carry the unit with the card still connected.

Carrying the unit with the card connected can cause loss of the card
due to it falling from the unit.

B Alithium ion battery is used as the built-in battery.

Please request the dealer from whom the Pocket PC was purchased
to replace the built-in battery when this becomes necessary.

Lithium ion batteries are recyclable. When you replace your built-in
battery, please request that the repair center recycle the battery.
Never dispose of the battery with ordinary waste.

The battery is a lithium ion battery, which can explode if not properly
replaced, used, handled or disposed of. Dispose of the battery as required
by local ordinances or regulations. Use only batteries recommended by
Toshiba as replacements.

Working environment

User's Manual

This product was designed to fulfill the EMC (electromagnetic
compatibility) requirements for “residential, commercial and light industry
environments”.

Toshiba does not approve the use of this product in working
environments other than “residential, commercial and light industry
environments”.

For example, the following environments are not approved:

B Industrial Environments (environments with a mainvoltage >230V~)
B Medical Environments

B Automotive Environments

B Aircraft Environments

Any consequences resulting from the use of this product in working
environments that are not approved are not the responsibility of Toshiba
Corporation. The consequences of the use of this product in non-
approved working environments may be:

B Interference with other devices or machines in the nearby surrounding
area

B Malfunction of, or data loss from, this product caused by disturbances
generated by other devices or machines in the nearby surrounding
area
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Therefore Toshiba strongly recommends that the electromagnetic
compatibility of this product be suitably tested in all non-approved
working environments before use. In the case of automobiles or aircraft,
the manufacturer or airline respectively should be asked for permission
before use of this product.

Furthermore, for general safety reasons, the use of this product in
environments with explosive atmospheres is not permitted.

CE compliance

This product and the original options are designed to observe the related
EMC (Electromagnetic compatibility) and safety standards. However,
Toshiba cannot guarantee that this product still observes these EMC
standards if options or cables not produced by Toshiba are connected or
implemented. In this case, the persons who have connected /
implemented those options / cables have to make sure that the system
(PC plus options / cables) still fulfils the required standards. To avoid
general EMC problems, the following advice should be observed:

B Only CE marked options should be connected / implemented
B Only best shielded cables should be connected

FCC Notice “Declaration of Conformity”

This equipment has been tested and found to comply with the limits for a
Class B digital device, pursuant to part 15 of the FCC Rules. These limits
are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses
and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct
the interference by one or more of the following measures:

B Reorient or relocate the receiving antenna
B Increase the separation between the equipment and receiver

B Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected

B Consult the dealer or an experienced radio/TV technician for help.
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Only peripherals complying with the FCC class B limits may be attached
to this equipment. Operation with non-compliant peripherals or
peripherals not recommended by Toshiba is likely to result in interference
to radio and TV reception. Shielded cables must be used between the
external devices and the computer’s USB ports, external monitor port,
PS/2 keyboard port and PS/2 mouse port. Changes or modifications
made to this equipment, not expressly approved by Toshiba or parties
authorized by Toshiba could void the user’s authority to operate the
equipment.

This device complies with part 15 of the FCC Rules. Operation is subject
to the following two conditions:

1 This device may not cause harmful interference

2 This device must accept any interference received, including
interference that may cause undesired operation.

Canadian Regulatory Information (Canada Only)

User's Manual

This digital apparatus does not exceed the Class B limits for radio noise
emissions from digital apparatus as set out in the Radio Interference
Regulation of the Canadian Department of Communications.

Note that Canadian Department of Communications (DOC) regulations
provide, that changes or modifications not expressly approved by
TOSHIBA Corporation could void your authority to operate this
equipment.

This Class B digital apparatus meets all requirements of the Canadian
Interference-Causing Equipment Regulations.

Cet appareil numérique de la class B respecte toutes les exgences du
Réglement sur le matériel brouilleur du Canada.

Xi
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FCC Class B Digital Devices & Peripheral Devices
(Declaration of Conformity or Certification
Authorization)

Declaration of Conformity Label & Marking Requirements

User Manual must provide user information in accordance with
+15.19(a)(3), 15.21, 15.27 and 15.105(b):

Instruction Manual Federal Communication Commission
Interference Statement

This equipment has been tested and found to comply with the limits for a
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits
are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses
and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct
the interference by one of the following measures:

B Reorient or relocate the receiving antenna
B Increase the separation between the equipment and receiver

B Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected

B Consult the dealer or an experienced radio/TV technician for help.

FCC Caution: Assure continued compliance (for example, use only
shielded interface cables when connecting to computer or peripheral
devices). Any changes or modifications not expressly approved by the
manufacturer of this device could void the user's authority to operate this
equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject
to the following two conditions: (1) This device may not cause harmful
interference, and (2) this device must accept any interference received,
including interference that may cause undesired operation.

Responsible Party: (Name)
(Address In U.S.A))
Telephone No: (1-800 number located in U.S.A.)
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TOSHIBA Pocket PC e310

Chapter 1

Getting Started

Welcome

Congratulations on purchasing your Toshiba Pocket PC. Due to the size
and capabilities of this device, you can keep your most important
business and personal information up-to-date and close at hand.
Microsoft® ActiveSync®increases the power of your device by allowing
you to synchronize the information on your desktop or laptop computer
with your device. Picture yourself in the following situations:

B While walking with a colleague, your cell phone rings and your
manager asks if you two are free this afternoon for an emergency
meeting. While your colleague fumbles through his paper organizer,
you press a button on your device and instantly see a list of today’s
appointments and meetings. You are quickly able to tell your manager
your available times. For more information on scheduling
appointments and meetings, see Chapter 4.

B You’re meeting your friends tonight for dinner and a movie. You
download the latest movie information from the Internet to your
desktop computer and then synchronize it with your device. At dinner,
you pull out your Toshiba Pocket PC device and review your movie
options with your friends. For more information on downloading Web
pages to your device, see Chapter 6.

B A Calendar reminder alerts you that it is time to catch the bus. You
grab your Toshiba Pocket PC device and catch the bus just in time.
Because ActiveSync keeps the information on your device up-to-date,
you leisurely review your task list, make notes about the new books
and CDs you want to buy, and read and respond to e-mail messages.
When you get back to the office, ActiveSync transfers any task
changes you made, your notes, and your e-mail message responses
to your desktop computer. For more information on ActiveSync, see
Chapter 3.
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Where to Find Information

User's Manual

This book describes your Pocket PC’s hardware, provides an overview of
the programs on your Pocket PC, and explains how to connect your
Pocket PC to a computer. For instructions on setting up your Pocket PC
and installing ActiveSync, see the Quick Start Card. The following table is
a guide to additional information to help you use your Pocket PC.

For information on:

Programs on your
Pocket PC

Additional programs
that can be installed on
the Pocket PC

Connecting to and
synchronizing with a
computer

Last-minute updates
and detailed technical
information

Up-to-date information
on your Toshiba
Pocket PC

See this source:

This User's Manual and device Help. To view
Help, tap Ff] and then Help.

The Toshiba Pocket PC Companion CD.

The Quick Start Card or ActiveSync Help on your
computer. To view Help, click Help and then
Microsoft ActiveSync Help.

The Read Me files, located in the Microsoft
ActiveSync folder on the Toshiba Pocket PC
computer and on the Toshiba Pocket PC
Companion CD.

http://www.pda.toshiba.com
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Chapter 2

Basic Skills

You can easily learn to use your Toshiba Pocket PC. This chapter
describes the use and customization of your Toshiba Pocket PC.

Parts Names and Function

Main unit (front view)

Power Button/Front Light
SD Card slot

Stereo Headphone Jack

Battery/Alarm Lamp LED

Recording Button
(Program Button 5)

Touch Screen

Speaker

Cursor Button/Navigation Button

Program Button 1, 2, 3, & 4
(from the left)

Battery Switch \ Cradle Connection Port

\ DC-IN Socket
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The Cradle

Initial Setting of Program Button

Program button 1 = Calendar 23]
Program button 2 = Tasks
Program button 3 = Home 1t
Program button 4 = Contacts
Program button 5 = Voice recorder

Main unit (back view)

Stylus Holder

IR Lens

Microphone

Stylus Recording Button

Scroller

SD Card slot /

DC-IN Socket
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Power Button

The power button turns the unit and the front light on and off.

Power button When the power is When the power is
off on
Press and hold it. The power turns on. The front light alternately

turns on/off.

Press it quickly. The power turns on. The power turns off.

Battery Switch

The battery switch supplies/cuts off the battery power to the Toshiba
Pocket PC.

S

/

/
Supply «— Stop

Battery Switch ——

The setting of this switch at shipment is “stop”. When using the Toshiba
Pocket PC for the first time, slide this switch to the left (the “supply” side)
with the stylus.

A Switching the battery switch to the “stop” position at any time will lead to
loss of data.

Alarm Lamp LED
The alarm lamp indicates the machine condition.

Flashing orange When the preset alarm time, which was set
through Calendar or Tasks, goes off, the lamp
flashes.

Glows orange Indicates charging of the built-in battery.

Glows yellow The built-in battery charging process is stopped

due to the ambient temperature being too high
or low. Charge the built-in battery in an ambient
temperature of approx. 5°C to 35°C.

Glows green Indicates full charge of the built-in battery.
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How to Use the Stylus

| [

The stylus is used for menu selection or data input on the touch-screen of
the Toshiba Pocket PC.

B Tap: Touch the screen once with the stylus to open items and select
options.

B Drag: Hold the stylus on the screen and drag it across to select text
and images. Drag in a list to select multiple items.

B Tap and hold: Tap and hold the stylus on an item to see a list of
actions available for that item. On the pop-up menu that appears, tap
the action you want to perform.

When you operate the touch screen of the Toshiba Pocket PC, use the
supplied stylus.

If the tip of the stylus is damaged, do not use it. If you operate the touch
screen with a damaged stylus or a ballpoint pen, the touch screen may be
damaged.

When the stylus is damaged, please purchase a new one.

About the Cursor Button

You can move a cursor (selection display) on the screen by pressing the
upper, lower, right or left part of the cursor button.

You can select a program to launch by pressing the center part of the
cursor button.

About the Scroller

|10

User's Manual

You can also move the cursor on the screen by moving the scroller up
and down.

You can select a program to launch by pressing the scroller.

The cursor movement is different depending on the screen. When the
cursor is at the right or the left side of the screen, it may not move.
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Battery Charging

A built-in battery is installed in the Toshiba Pocket PC. When using the
Toshiba Pocket PC for the first time, set the battery switch to the supply
side, and then charge the built-in battery with the supplied AC adapter.

How to Charge the Battery

You can use two charging methods.
O
l Turn the unit off before connecting the AC Adapter and Pocket PC.

Method 1. Connect the supplied AC adapter and the cradle as shown in
the figure below, and then insert the Toshiba Pocket PC into the cradle.

Method 2. Connect the supplied AC adapter and the Toshiba Pocket PC
as shown in the figure below.

For charging the built-in battery, maintain an ambient temperature from
approx. 5°C to 35°C.

When the lamp glows orange or green during the built-in battery charging,
you can use the Toshiba Pocket PC.

When the built-in battery is completely charged, the Battery/Alarm lamp
LED color will change to green.

| [
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How to Prolong Battery Life

Use the Toshiba Pocket PC with the AC adapter.

When you use the Toshiba Pocket PC under the following conditions,
the power consumption will be higher than normal. Please use the AC
adapter when:

The Toshiba Pocket PC is operated while connected to your
computer.

The Toshiba Pocket PC is operated with a storage card or with any
other optional equipment.

Select the short power-off time in the setting menu. This will shorten
the time the unit will remain on if not used. For more information, see
“Customize Your Toshiba Pocket PC” in this chapter.

Turn off the front light.
Set the screen brightness to power save mode (Med Bright or low

Bright). Also shorten the light turn-off time. For more information, see
“Customize Your Toshiba Pocket PC” in this chapter.

Use the Toshiba Pocket PC with an ambient temperature between
15°C (59°F) and 25°C (77°F). This temperature range is the most
effective for the built-in battery.

When you use the Toshiba Pocket PC in high or low temperature
environments, the operable time is shortened due to the decrease
of the built-in battery capacity.

Battery Life

The built-in battery has a limited life. Repeated charging/discharging of
the built-in battery gradually decreases operable time.

VAN
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Do not leave the Toshiba Pocket PC in a place of high or low
temperature. It may shorten battery life.

If you have not used the Toshiba Pocket PC for several days, its battery
charge level reading may be inaccurate. Fully recharge the battery for 2-3
hours before using.
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Battery Charge Level and Stored Data Protection

| [

If the battery charge level becomes extremely low, or is completely
discharged, the memory data stored in the Toshiba Pocket PC will be
deleted.

When the low battery status icon or the alarm message appears,
immediately connect the AC adapter to your Toshiba Pocket PC and
charge the built-in battery.

The built-in battery gradually discharges even if the device is not being
used. When the Toshiba Pocket PC is left for a long time, the built-in
battery of the Toshiba Pocket PC may completely discharge.

As a precaution, it is recommended that you save the Toshiba

Pocket PC’s memory data to your computer or to a storage card.

The manufacturer is not responsible for data change or data loss due to
battery discharge.

Initial Setup

|10
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When using the Toshiba Pocket PC for the first time, carry out the initial
setup according to the procedures below after the built-in battery has
been charged.

1 Move the battery switch to the “supply” position. The Toshiba
Pocket PC powers on automatically and the Welcome screen
appears. Tap the screen to start the following setup.

2 Execute touch screen alignment.

When the alignment screen appears, tap the center of the cross target
with the stylus. The next target position changes upon tapping the
target. Five taps completes the positioning alignment. The screen then
changes to the Stylus screen.

If a finger or any other object besides the stylus touches the
screen during alignment, the alignment will be cancelled and you
must repeat the procedure.

3 Read how to use the stylus.
Read and understand the stylus operation, and then tap NEXT.

For more information on stylus operation, see “How to Use the Stylus” in
this chapter.

4 Learn the pop-up menu operation.
Read the on-screen explanation and then follow the instructions.

Display the pop-up menu, and cut and paste the data according to
the screen instructions.

After you finish the paste operation, this stage is completed. Tap
NEXT.
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5 Set the TIME ZONE.

When tapping the right W mark, the city and the time zone list
appears. Tap the desired city and time zone.

When the setup is completed, tap NEXT.

6 Complete the initial setup.
When the Complete screen appears, the initial setup is completed.
After tapping the screen, you can use the Toshiba Pocket PC.

O
l; When you tap the Complete screen, the Today screen appears. For more
information , see “Today screen” in this chapter.

Method of Setting Card into SD Card Slot

To insert a card:

Turn off the power. Insert the card with its contact surface (metal contact
surface) facing the back of the Toshiba Pocket PC.
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To remove a card:

1 Turn off the power.

2 Lightly press down the card until a clicking sound is heard. The card
will pop out slightly from the slot.

3 Pull the card straight up to remove.

Connecting a Remote Control-Fitted Earphone
You can listen to the sound output from your PocketPC by connecting the
optional remote control-fitted earphone microphone.

Insert the remote control-fitted earphone plug into the stereo headphone
jack.

Use the specified remote control-fitted earphone. If you use a different
type of earphone, it may result malfunction.

The connectable pin size of the headphone/earphone is 3.5 mm mini
plug type.

Connecting to a Computer

User's Manual

Before connecting your Toshiba Pocket PC to a computer, check the
following.

B ActiveSync has been installed on your computer. (See Chapter 3.)
B Make sure that the Pocket PC and your computer are both turned off.

B The position of connecting port on the computer may differ according
to the computer type.
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To Connect Using The Supplied Cradle:

1 Connect the Client cradle to your computer as shown in the illustration
below.

2 Insert the Pocket PC into the cradle.
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To connect directly using a connection cable:
Connect the Pocket PC directly to your computer using an optional USB
Client cable.

A When the Pocket PC is connected to another device via a USB Client
cable do not plug the AC adapter directly into the Pocket PC as this may

lead to interference. Instead, plug the AC adapter into the port on the
USB Client cable connector.
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Today Screen
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When you turn on your device for the first time each day (or after 4 hours
of |nact|V|ty) you’ll see the Today screen. You can also display it by

] and then Today. On the Today screen, you can see at a
glance important information for the day.

Following are some of the status icons you may see.

Tap to switch to a
program.

Tap to view notification messages.

Tap to change the volume level or to turn the volume on/off.

F3 £ 8:14

@ Wednesday, August 22, 2001 ——— Tap to change date and time.
E Owner: Adam Barr Tant " inf i ind
(206 555-1212 +——— Tap to open the ower information window.
E Status Meeting
10:0048-11:004M (Room 3193
|_| Mo unread MEs530es Your day at a glance.
1 Active task
1 High priority
New @EI — Tap to view connection status.

L Tap to create a new item.
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Following are some of the status icons you may see.

Status Icon

<

i

Meaning

Turns all sounds on and off

Backup battery is low

Main batteries are charging

Main batteries are low

Main batteries are very low

Main batteries are full

Connection is active

Synchronization is beginning or ending
Synchronization is occurring

Notification that one or more instant messages
were received

Notification that one or more e-mail messages
were received

If more notification icons need to be displayed then there is room to
display them, the Notification icon, 3, will display. Tap the icon to view all

notification icons.
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Programs
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You can switch from one program to another by selecting it from the ki
menu. (You can customize which programs you see on this menu. For
information, see “Adjusting Settings,” later in this chapter.) To access
some programs, you'll need to tap i, Programs, and then the program
name.

You can also switch to some programs by pressing a program button.
Your device has one or more program buttons located on the front or side
of the device. The icons on the buttons identify the programs they switch
to.

Some programs have abbreviated labels for check boxes and drop-down
menus. To see the full spelling of an abbreviated label, tap and hold the
stylus on the label. Drag the stylus off the label so that the command is
not carried out.

The following table contains a partial list of programs that are on your
device. Look on the Toshiba Pocket PC Companion CD for additional
programs that you can install onto your device.

Program Description

ActiveSync Synchronize information between your
Pocket PC and desktop computer.

Calendar Keep track of your appointments and create
meeting requests.

Contacts Keep track of your friends and colleagues.

Inbox Send and receive e-mail messages.

Pocket Internet Explorer Browse Web and WAP sites, and download new
programs and files from the Internet.

Notes Create handwritten or typed notes, drawings,
and recordings.

Tasks Keep track of your tasks.

Pocket Excel Create Excel spreadsheet or view and edit Excel

spreadsheet created on your desktop computer.

MSN Messenger Send and receive instant messages with your
MSN Messenger contacts.

Pocket Word Create new documents or view and edit Word
documents created on your desktop computer.
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Navigation Bar and Command Bar
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The navigation bar is located at the top of the screen. It displays the
active program and current time, and allows you to switch to programs
and close screens.

Use the command bar at the bottom of the screen to perform tasks in
programs. The command bar includes menu names, buttons, and the
Input Panel button. To create a new item in the current program, tap
New. To see the name of a button, tap and hold the stylus on the button.
Drag the stylus off the button so that the command is not carried out.

Tap to change volume or mute the Pocket PC.

Ei‘_’.y“ﬁtart % 12:08
Hd @

Tap to quickly select a program you have recently used.

(A Today

@ ActiveSync

[=] Calendar

[=] Contacts

(=) Inbox

@ Internet Explorer
[_| Motes
Tasks
I Programs
@ Settings
[ Find

i) Help

Tap to select a program.

Tap to see additional programs.

Tap to customize the Pocket PC.

r New button. Input panel button.

‘Néw Edit Tools =1 EI“
Buttons.

Menu names.
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Pop-up Menus

With pop-up menus, you can quickly choose an action . For example, you
can use the pop-up menu in the contact list to quickly delete a contact,
make a copy of a contact, or send an e-mail message to a contact. The
actions in the pop-up menus vary from program to program. To access a
pop-up menu, tap and hold the stylus on the item name that you want to
perform the action on. When the menu appears, lift the stylus, and tap the
action you want to perform. To close the menu without performing an
action, tap anywhere outside the menu.

All Tasks Priority -

[ ] * Send status report
[] Buy birthday gift
[] callMaria

] Proof new proposal

Wl 1 _cchedule massage +— Tap and hold to display the pop-up menu.

Create Copy

Delete Task Lift the stylus and tap the action you want.

Beam Task...

— Tap outside the menu to close it without performing
an action.

New Tools E|A

Notifications

User's Manual

Your device reminds you in a variety of ways when you have something to
do. For example, if you’ve set up an appointment in Calendar, a task with
a due date in Tasks, or an alarm in Clock, you’ll be notified in any of the
following ways:

B A message box appears on the screen
B A sound, which you can specify, is played
B A light flashes on your device

To choose reminder types and sounds for your device, tap i and then
Settings. In the Personal tab, tap Sounds & Notifications. The options
you choose here apply throughout the device.
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Enter Information on Your Toshiba Pocket PC

You have several options for entering new information:

Use the input panel to enter typed text, either by using the soft
keyboard or other input method

Write directly on the screen
Draw pictures on the screen
Speak into your device microphone to record a message

Use Microsoft® ActiveSync®to synchronize or copy information from
your desktop computer to your device. For more information on
ActiveSync, see ActiveSync Help on your desktop computer.

Entering Text Using the Input Panel

Use the input panel to enter information in any program on your device.

You can either type using the soft keyboard or write using Letter
Recognizer, Block Recognizer, or Transcriber. In either case, the
characters appear as typed text on the screen.

To show or hide the input panel, tap the Input Panel button. Tap the
arrow next to the Input Panel button to see your choices.

User's Manual

Options...

Block Recognizer
L ]

Keyboard Select an input method.
Letter Recognizer

Transcriber

Tap to see your choices.

New Edit Yiew Tools T @H

Input panel button.
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When you use the input panel, your device anticipates the word you are
typing or writing and displays it above the input panel. When you tap the
displayed word, it is inserted into your text at the insertion point. The
more you use your device, the more words it learns to anticipate.

Tap here if this is the right word.

|meetiﬂ|
123(1[2[3]4]5]6[7|s]a]o]-][=[«
Tabla[wle[r[t{y[uli[o[p[[]]
caPlas[d[f[a[n]i[k[1]:]"

shift z[x[c¥[b[n[m][,[.]/]+
ctfain] - [A] [t ]e]>
New Edit Tools = 7 = |~

To change word suggestion options, such as the number of words
suggested at one time, tap Settings, Personal tab, Input, and then
the Word Completion tab.

To type with the soft keyboard:

1 Tap the arrow next to the Input Panel button and then Keyboard.
2 On the soft keyboard that is displayed, tap the keys with your stylus.

To use Letter Recognizer:
With Letter Recognizer you can write letters using the stylus just as you
would on paper.

1 Tap the arrow next to the Input Panel button and then Letter
Recognizer.

2 Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the
screen. For specific instructions on using Letter Recognizer, with Letter
Recognizer open, tap the question mark next to the writing area.
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To use Block Recognizer:
With Block Recognizer you can input character strokes using the stylus
that are similar to those used on other devices.

1 Tap the arrow next to the Input Panel button and then Block
Recognizer.

2 Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the
screen. For specific instructions on using Block Recognizer, with Block
Recognizer open, tap the question mark next to the writing area.

To use Transcriber:

With Transcriber you can write anywhere on the screen using the stylus
just as you would on paper. Unlike Letter Recognizer and Block
Recognizer, you can write a sentence or more of information. Then, pause
and let Transcriber change the written characters to typed characters.

1 Tap the arrow next to the Input Panel button and then Transcriber.
2 Write anywhere on the screen.

For specific instructions on using Transcriber, with Transcriber open, tap
the question mark in the lower right hand corner of the screen.

To select typed text:
If you want to edit or format typed text, you must select it first.

B Drag the stylus across the text you want to select.

You can cut, copy, and paste text by tapping and holding the selected
words and then tapping an editing command on the pop-up menu, or by
tapping the command on the Edit menu.
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Writing on the Screen
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In any program that accepts writing, such as the Notes program, and in
the Notes tab in Calendar, Contacts, and Tasks, you can use your stylus
to write directly on the screen. Write the way you do on paper. You can
edit and format what you’ve written and convert the information to text at
a later time.

To write on the screen:

B Tap the Pen button to switch to writing mode. This action displays
lines on the screen to help you write.

Tap the Pen button and use your stylus like a pen.
[+

New Edit Tools E@ E|A

Some programs that accept writing may not have the Pen button. See the
documentation for that program to find out how to switch to writing
mode.

To select writing:

If you want to edit or format writing, you must select it first.

1 Tap and hold the stylus next to the text you want to select until the
insertion point appears.

2 Without lifting, drag the stylus across the text you want to select.

If you accidentally write on the screen, tap Tools, then Undo and try

again. You can also select text by tapping the Pen button to deselect it

and then dragging the stylus across the screen.

You can cut, copy, and paste written text in the same way you work with

typed text: tap and hold the selected words and then tap an editing

command on the pop-up menu, or tap the command on the Edit menu.
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To convert writing to text:

B Tap Tools and then Recognize.

If you want to convert only certain words, select them before tapping
Recognize on the Tools menu (or tap and hold the selected words and
then tap Recognize on the pop-up menu). If a word is not recognized, it
is left as writing.

Cuk
Copy
Clear
Recognize — | | ||
- -
New Edit Tools = |££ E|A New Edit Tools = E|A
Select the text you want to convert
and Tap Recognize on the pop-up menu. The writing is turned into text.
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If the conversion is incorrect, you can select different words from a list of
alternates or return to the original writing. To do so, tap and hold the
incorrect word (tap one word at a time). On the pop-up menu, tap
Alternates. A menu with a list of alternate words appears. Tap the word
you want to use, or tap the writing at the top of the menu to return to the
original writing.

¢ 955
re

Toens |
ﬂ t P O /{; T;’ Tap to return to your original writing.

report!

Or, tap the word you want to use.

Report!

o [m[ ) [ |m[ut
New Edit Tools |E||é| E|*

Tips for getting good recognition:

B Write neatly.

B Write on the lines and draw descenders below the line. Write the cross
of the “t” and apostrophes below the top line so that they are not

confused with the word above. Write periods and commas above the
line.

B For better recognition, try increasing the zoom level to 300% using the
Tools menu.

B Write the letters of a word closely and leave big gaps between words
so that the device can easily tell where words begin and end.

B Hyphenated words, foreign words that use special characters such as
accents, and some punctuation cannot be converted.

B If you add writing to a word to change it (such as changing a “3” to an
“8”) after you attempt to recognize the word, the writing you add will
not be included if you attempt to recognize the writing again.
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Drawing on the Screen

jud'o
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You can draw on the screen in the same way that you write on the
screen. The difference between writing and drawing on the screen is how
you select items and how they can be edited. For example, selected
drawings can be resized, while writing cannot.

To create a drawing

B Cross three ruled lines on your first stroke. A drawing box appears.
Subsequent strokes in or touching the drawing box become part of
the drawing. Drawings that do not cross three ruled lines will be
treated as writing.

The drawing box indicates the boundaries of the
drawing.

0

Pen button.

New Edit Tools E@ (8

You may want to change the zoom level so that you can more easily work
on or view your drawing. Tap Tools and then a zoom level.

To select a drawing

If you want to edit or format a drawing, you must select it first.

B Tap and hold the stylus on the drawing until the selection handle
appears. To select multiple drawings, deselect the Pen button and
then drag to select the drawings you want.

You can cut, copy, and paste selected drawings by tapping and holding

the selected drawing and then tapping an editing command on the popup

menu, or by tapping the command on the Edit menu. To resize a drawing,
make sure the Pen button is not selected, and drag a selection handle.
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Recording a Message
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In any program where you can write or draw on the screen, you can also
quickly capture thoughts, reminders, and phone numbers by recording a
message. In Calendar, Tasks, and Contacts, you can include a recording
in the Notes tab. In the Notes program, you can either create a
standalone recording or include a recording in a written note. If you want
to include the recording in a note, open the note first. In the Inbox
program, you can add a recording to an e-mail message.

To create a recording:
1 Hold your device’s microphone near your mouth or other source of
sound.

2 Press and hold the Recording button on your Pocket PC until you hear
a beep.

3 While holding down the Recording button, make your recording.

4 To stop recording, release the Recording button. Two beeps will
sound.

The new recording appears in the note list or as an embedded icon.

You can also make a recording by tapping the Recording button on the
Recording toolbar.

To play a recording, tap it in the list or tap its icon in the note.

@ : Indicates an embedded recording.

______ from Adam
Tap to begin recording.
......................................................................... g a6 show o hide the Hesording osbar
T k |
o(m)) (= REEET
New Edit Tools |E||é| E|*
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Using My Text
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When using Inbox or MSN Messenger, use My Text to quickly insert
preset or frequently used messages into the text entry area. To insert a
message, tap My Text and tap a message.

You can add text after inserting a My Text message before sending it.
To edit a My Text message, in the Tools menu, tap Edit and then tap My

Text Messages . Select the message you wish to edit and make desired
changes.

Hi, Can you meek ak 2:007

1 have another appoinkment scheduled For 2:00,
bk am &y ailal

Tes.

No.

I can't talk right now.
I'll be right there.
I'm running late.

Last messagg
Where are you?

123[1[2[3] i |
Tab[q]w] e . ;
caplals Goodbye.

chift| z [ = Call me later.

ctufaa] " [§ IlovemyPocketPC!

.3

Tools Chats |My 'I"EHtLi \EJ

L Tap to select a prewritten message.
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Find and Organize Information
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The Find feature on your device helps you quickly locate information.

B Onthe menu, tap Find. Enter the text you want to find, select a
data type, and then tap Go to start the search.

To quickly find information that is taking up storage space on your
Pocket PC, select Larger than 64 KB in Type.

You can also use the File Explorer to find files on your device and to
organize these files into folders. On the EE] menu, tap Programs, and
then File Explorer.

% Tap to change folders.

My Device - Name |
1My Documents
[T Program Files
21 Temp
1 Windows
mdmlogs 10/01/.. 54B

Select the sort order for the list.

Tap the folder name to open it.

Refresh
Yiew All Files

Paste
Paste Shortcor Tap and hold to create a new folder.

MNew Folder

Edit Open |~ ) 2 =]

You can move files in File Explorer by tapping and holding the item you
want to move, and then tapping Cut or Copy and Paste on the pop-up
menu.
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Customize Your Toshiba Pocket PC

You can customize your device by adjusting device settings and installing
additional software.

Adjusting Settings

You can adjust device settings to suit the way you work. To see available
options, tap [, Settings, then the Personal or System tab located at the
bottom of the screen.

You might want to adjust the following:
B Clock, to change the time or to set alarms

B Menus, to customize what appears on the [i] menu, and to enable a
pop-up menu from the New button

Owner Information, to enter your contact information
Password, to limit access to your device
Power, to maximize battery life

Today, to customize the look and the information that is displayed on
the Today screen

Adding or Removing Programs

User's Manual

Programs added to your device at the factory are stored in ROM (read-
only memory). You cannot remove this software, and you’ll never
accidentally lose ROM contents. ROM programs can be updated using
special installation programs with a *.xip extension. All other programs
and data files added to your device after factory installation are stored in
RAM (random access memory).

You can install any program created for your device, as long as your
device has enough memory. The most popular place to find software for
your device is on the Pocket PC Web site
(http://www.microsoft.com/mobile/pocketpc).

To add programs using ActiveSync

You’'ll need to install the appropriate software for your device on your
desktop computer before installing it on your device.

1 Determine your device and processor type so that you know which
version of the software to install. Tap i and then Settings. On the
System tab, tap About. In the Version tab, make a note of the
information in Processor.

2 Download the program to your desktop computer (or insert the CD or
disk that contains the program into your desktop computer). You may
see a single *.xip, *.exe,, or *.zip file, a Setup.exe file, or several
versions of files for different device types and processors. Be sure to
select the program designed for the Toshiba Pocket PC and your
device processor type.
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3 Read any installation instructions, Read Me files, or documentation
that comes with the program.

Many programs provide special installation instructions.
4 Connect your device and desktop computer.
5 Double-click the *.exe file.

If the file is an installer, the installation wizard will begin. Follow the
directions on the screen. Once the software has been installed on

your desktop computer, the installer will automatically transfer the
software to your device.

If the file is not an installer, you will see an error message stating
that the program is valid but it is designed for a different type of
computer. You will need to move this file to your device. If you
cannot find any installation instructions for the program in the
Read Me file or documentation, use ActiveSync Explore to copy
the program file to the Program Files folder on your device. For
more information on copying files using ActiveSync, see
ActiveSync Help.

Once installation is complete, tap [f], Programs, and then the program
icon to switch to it.

To add a program to the Start menu

Tap EF], Settings, Menus , the Start Menu tab, and then mark the check
box for the program. If you do not see the program listed, you can either
use File Explorer on the device to move the program to the Start Menu
folder, or use ActiveSync on the desktop computer to create a shortcut to
the program and place the shortcut in the Start Menu folder.

B Using File Explorer on the device:Tap [, Programs, File Explorer,
and locate the program (tap the folder list, labeled My Documents by
default, and then My Device to see a list of all folders on the device).
Tap and hold the program and tap Cut on the pop-up menu. Open the
Start Menu folder located in the Windows folder, tap and hold a blank
area of the window, and tap Paste on the pop-up menu. The program
will now appear on the menu. For more information on using File
Explorer, see “Find and Organize Information,” earlier in this chapter.

B Using ActiveSync on the desktop computer:Use the Explorer in
ActiveSync to explore your device files and locate the program.
Rightclick the program, and then click Create Shortcut. Move the
shortcut to the Start Menu folder in the Windows folder. The shortcut
now appears on the [&] menu. For more information, see ActiveSync
Help.

To remove programs
B Tap [F and then Settings. On the System tab, tap Remove
Programs

If the program does not appear in the list of installed programs, use File
Explorer on your device to locate the program, tap and hold the program,
and then tap Delete on the pop-up menu.
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Setting a Password
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You can protect data or settings from a third person by setting a
password which is requested when turning power on.

1 Tap [f] and then Settings. On the Personal tab, tap Password.
Select the type of password you would like to use.
Enter a password and tap OK.

Tap YES on the confirmation screen. The password is saved and the
screen returns to the Personal tab screen

H WODN

If you tab YES on the confirmation screen to return to the Personal tab
screen, it becomes necessary to enter the password even for displaying
the Password setting screen.

In case you forget the password, it is necessary to initialize the Pocket PC.
Please note that when initialization is executed, data or settings stored in
the Pocket PC are all deleted.

Setting Frontlight

You can set the screen brightness for better sight according to a place of
use. You can also set the time that elapses until the front light turns off
automatically after the last operation.

1 Tap [f] and then Settings. On the System tab, tap Frontlight.
2 Perform your Frontlight settings according to your needs.
3 When finished, tap OK to return to the System tab screen.

Setting Power
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You can set to confirm the built-in battery remaining power and the time
that elapses until the power turns off after the last operation.

1 Tap [f] and then Settings. On the System tab, tap Power.
2 Perform your Power settings according to your needs.
3 When finished, tap OK to return to the System tab screen.
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Setting Memory
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You can adjust the data storing memory and the program running
memory. You can also confirm the free space of a storage card and so
on. Memory for the Pocket PC is managed automatically.

To change Memory allocation:
1 Tap [f] and then Settings. On the System tab, tap Memory to display
the Memory setting screen.

2 Drag the knob widthwise to adjust the memory allocation between
Storage and Program.

3 When finished, tap OK to return to the System tab screen.

To confirm usage status of a storage card:

1 Tap Storage Card tab on the Memory setting screen.
2 When finished, tap OK to return to the System tab screen.

To release memory:
If memory is running short of its capacity, i.e., error message display, the
following methods are available to release the memory.

B Transfer data to a storage card and the like and delete them from the
Pocket PC.

B Delete unnecessary files.
B Quit a program in execution.
B Delete a program not in use.

For more information on detailed operation method or the memory release
method other than the above, see the online help.
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Chapter 3

Microsoft ActiveSync

| [

Using Microsoft® ActiveSync®,you can synchronize the information on
your desktop computer with the information on your device.
Synchronization compares the data on your device with your PC and
updates both computers with the most recent information. For example:

B Keep Pocket Outlook data up-to-date by synchronizing your device
with Microsoft Outlook data on your PC.

B Synchronize Microsoft Word and Microsoft Excel files between your
device and desktop computer.

Your files are automatically converted to the correct format.

By default, ActiveSync does not automatically synchronize all types of
information. Use ActiveSync options to turn synchronization on and off for
specific information types.

With ActiveSync, you can also:
B Back up and restore your device data.

B Copy (rather than synchronize) files between your device and desktop
computer.

B Control when synchronization occurs by selecting a synchronization
mode. For example, you can synchronize continually while connected
to your desktop computer or only when you choose the synchronize
command.

B Select which information types are synchronized and control how
much data is synchronized. For example, you can choose how many
weeks of past appointments you want synchronized.

Before you begin synchronization, install ActiveSync on your PC from the
Toshiba Pocket PC Companion CD. For more information on installing
ActiveSync, see your Quick Start card. ActiveSync is already installed on
your device.

After installation is complete, the ActiveSync Setup Wizard helps you
connect your Pocket PC to your PC, set up a partnership so you can
synchronize information between your Pocket PC and your PC, and
customize your synchronization settings. Your first synchronization
process will automatically begin when you finish using the wizard.
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Microsoft ActiveSync

After your first synchronization, take a look at Calendar, Contacts, and
Tasks on your device. You'll notice that information you’ve stored in
Microsoft Outlook on your PC has been copied to your device, and you
didn’t have to type a word. Disconnect your device from your PC and
you’re ready to go!

Once you have set up ActiveSync and completed the first synchronization
process, you can initiate synchronization from your device. To switch to
ActiveSync on your device, tap [&], and then tap ActiveSync.

For information about using ActiveSync on your PC, start ActiveSync on
your PC and then see ActiveSync Help.

For more information about ActiveSync on your device, switch to
ActiveSync, tap [}, and then tap Help.

{3 | Activesync ¢ 11:35 €3
Connected —————— @ View connection status.

‘ Tap to connect and synchronize.
@ Sync 9 Stop Tap to stop synchronization.

Synchronize with PC
Last Syncy 4/25/01 10:52 AM

View synchronization status.

Tap to synchrinize via IR or change
synchronization settings.

1
Tools E|A
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Chapter 4

Microsoft Pocket Outlook

Microsoft® Pocket Outlook includes Calendar, Contacts, Tasks, Inbox,
and Notes. You can use these programs individually or together. For
example, e-mail addresses stored in Contacts can be used to address e-
mail messages in Inbox.

Using ActiveSync®you can synchronize information in Microsoft Outlook
or Microsoft Exchange on your desktop computer with your device. You
can also synchronize this information directly with a Microsoft Exchange
server. Each time you synchronize, ActiveSync compares the changes
you made on your device and desktop computer or server and updates
both computers with the latest information. For information on using
ActiveSync, see ActiveSync Help on the desktop computer.

You can switch to any of these programs by tapping them on the []
menu.
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Calendar: Scheduling Appointments and Meetings

|10
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Use Calendar to schedule appointments, including meetings and other
events. You can check your appointments in one of several views
(Agenda, Day, Week, Month, and Year) and easily switch views by using

the View menu.

fg Calendar

Augos,00 BMTwWTES §] «|»

YWorking at home

Lunch w/ Adam
12:00p-1:00p {Corner Cafe)

Status Meeting
icH :00p

— Tap to go to today.

Tap to display or edit the appointment details.

Tap to create a new appointment.

Néw Tools E @ @

E|A

You can customize the Calendar display, such as changing the first day of
the week, by tapping Options on the Tools menu.
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To create an appointment
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1 If you are in Day or Week view, tap the desired date and time for the
appointment.

2 Tap New.

Tap to return to the calendar (the appointment is
saved automatically).

.fg Calendar : f Tap to choose from predefined text.
Subject: —
Lacation: + |—— Tap to choose from previously entered locations.
Starks:
Ends: Tap to select a time.
Type:
Cocurs: Tap to select a date.
Reminder:

Categories: Mo cateqories...

Appointrent | Mokes l Notes is a good place for maps and directions.
123/1[2[3]4[s[6[7[8[9]0]- =4
Tabla[wle|r[t[y[uli[o[p|[]]
CaPlals[d[fla[h[ilk[1[;]"]
shirt z[2[c[v][b[n[m[.[. /]«
ctufad] - [\] [4]t]«]~+

Edit |E|:|

3 Using the input panel, enter a description and a location. Tap first to
select the field.

4 If needed, tap the date and time to change them.

5 Enter other desired information. You will need to hide the input panel
to see all available fields.

6 To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see “Notes:
Capturing Thoughts and Ideas,” later in this chapter.

7 When finished, tap OK to return to the calendar.

If you select Remind me in an appointment, your device will remind you
according to the options set in Settings, Personal tab, Sounds &
Notifications.
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Using the Summary Screen

When you tap an appointment in Calendar, a summary screen is
displayed. To change the appointment, tap Edit.

fg Calendar (a1 O

Lunch w,/ adam Fiy

View appointment details.
12:00p-1:00p Sun, 862000

Corner Cafe

Remember portfalio. View.

‘ Tap to change appointment.

Edit Tools E|A

Creating Meeting Requests

You can use Calendar to set up meetings with users of Outlook or Pocket
Outlook. The meeting request will be created automatically and sent
either when you synchronize Inbox or when you connect to your e-mail
server. Indicate how you want meeting requests sent by tapping Tools
and then Options. If you send and receive e-mail messages through
ActiveSync, select ActiveSync.

To schedule a meeting:

1 Create an appointment by tapping New.

2 In the appointment details, hide the input panel, and then tap
Attendees.

3 From the list of e-mail addresses you’ve entered in Contacts, select
the meeting attendees.

The meeting notice is created automatically and placed in the Outbox
folder.

For more information on sending and receiving meeting requests, see
Calendar Help and Inbox Help on the device.
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Contacts: Tracking Friends and Colleagues
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Contacts maintains a list of your friends and colleagues so that you can
easily find the information you’re looking for, whether you’re at home or
on the road. Using the device infrared (IR) port, you can quickly share
Contacts information with other device users.

Select the category of contacts you want
displayed in the list.

All Contacts ~ | —}— Tap and enter part of a name to quickly find it in
= the list.
#ab|cde] figh [ ik [ Imn]opg] rst juwe] xve
Barr, Adam {(206) 555-1212 w —|—— Tap to see additional phone numbers and e-mail
Bready, Richard rich@proseware.... e addresses.
Create Copy — Tap to display or edit the contact details.

Delete Contact

K —— Tap and hold to display a pop-up menu of
Send E-mail to Contact... actions.

Beam Contact...

ﬁ ———— Tap to create a new contact.

New Yiew Tools E|A

To change the way information is displayed in the list, tap Tools and then
Options.

4-5



Microsoft Pocket Outlook

To create a contact:

1

I

e

Company:
Workadd: 00007

Mobile tel:

Tap New.

Contacks Tap to return to the contact list (the contact is
saved automatically).
Mame: -

Job title:
partment:

Work tEI: ...............................................
Wark Fax:

E-mal:

= Scroll to see more fields.

Details | Motes | Notes is a good place for maps and directions.

123

1[2[3]4[s][6][7]8]o]o]-[=[+

Taplalwle]r [ ¢[y u]i]o]p]T

caplals[d[f[a]n]ilk[1];:]"

shitfz[x[c[v[b[n]m], [.

|
!

ctl

[ [4]
HilMA [t[t]<]=

Edit

L

2

3

5

Using the input panel, enter a name and other contact information.
You will need to scroll down to see all available fields.

To assign the contact to a category, scroll to and tap Categories and
select a category from the list. In the contact list, you can display
contacts by category.

To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see “Notes:
Capturing Thoughts and Ideas,” later in this chapter.

When finished, tap OK to return to the contact list.

Finding a contact

There are four ways to find a contact:

User's Manual

In the contact list, enter a contact name in the box under the
navigation bar. To show all contacts again, clear text from the box or
tap the button to the right of the box.

In the contact list, tap the category list (labeled All Contacts by
default) and select the type of contact that you want displayed. To
show all contacts again, select All Contacts. To view a contact not
assigned to a category, select No Categories.

To view the names of companies your contacts work for, in the
contact list, tap View > By Company. The number of contacts that
work for that company will be displayed to the right of the company
name.

Tap [, Find, enter the contact name, select Contacts for the type,
and then tap Go.
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When you tap a contact in the contact list, a summary screen is
displayed. To change the contact information, tap Edit.

fg Contacts

Adam Gabor
Programmer

R&D

Inspired Technologies

— View contact details.

Tap to change contact information.

(206) 555-1212 Woark, tel
111 First 5t wark, addr
Surnmaty | Motes !
Edit Tools E|A

Tap to view notes.

4-7



Tasks: Keeping a To Do List
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Use Tasks to keep track of what you have to do.

Priority |

All Tasks -

[]* Send status report
[ ]| Buy birthday gift
[] call Maria

[] Proof new proposal

Ml 1 _cchadule magsage

Create Copy
Delete Task

Beam Task...

New Tools

E|A

Select the category of tasks you want displayed in
the list.

—— Select the sort order of the list.

Indicates high priority.

—— Tap to display or edit the task details.

Tap and hold to display a pop-up menu of
actions.

Tap to create a new task.

To change the way information is displayed in the list, tap Tools and then

Options.
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To create a task:
1 Tap New.

jud'o
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=

Tap to return to the task list (the task is saved
automatically).

Subject:
Priarity:
Skatus:
Skarts:
[BINT=H

Tap to choose from predefined subjects.

Qcours:
Reminder:

ateqories: Mo categories...

Task. | Notes Notes is a good place for maps and drawings.

123

1[2[3]4

|
Tab|q[w]e[r

s[e[7]8]o]o]-[=[+
[ty ulifo[p[[]]

caplals[d[f[a]n]ilk[1];:]"

|
!

shift[z[x[c[v[b[nm], [. /]

ctifaa] " [\ ] [t[t]<]=

Edit B~

2 Using the input panel, enter a description.

3 You can enter a start date and due date or enter other information by
first tapping the field. If the input panel is open, you will need to hide it
to see all available fields.

4 To assign the task to a category, tap Categories and select a
category from the list. In the task list, you can display tasks by
category.

5 To add notes, tap the Notes tab. You can enter text, draw, or create a
recording. For more information on creating notes, see “Notes:
Capturing Thoughts and Ideas,” later in this chapter.

6 When finished, tap OK to return to the task list.

To quickly create a task with only a subject, tap Entry Bar on the Tools
menu. Then, tap Tap here to add a new task and enter your task
information.
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Using the Summary Screen

When you tap a task in the task list, a summary screen is displayed. To
change the task, tap Edit.

Send status report 4
——+—— View task details.
Starts: g/f18/2000
Due: 8/18,/2000 . -
A— Tap to s_how and hide additional summary
Send to the whale team using the new information.
format.
———— View notes.
Tap to change task.
Edit Tools E|*

User's Manual
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Notes: Capturing Thoughts and Ideas
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Quickly capture thoughts, reminders, ideas, drawings, and phone
numbers with Notes. You can create a written note or a recording. You
can also include a recording in a note. If a note is open when you create
the recording, it will be included in the note as an icon. If the note list is
displayed, it will be created as a stand-alone recording.

Personall

Create Copy
Delete
Select All |

Send via E-mail...
Beam File...

Rename;/Move...

@ All Folders Name = 1ap to change the sort order of the list.
[_|Business1 &54a 424b
[_]outlook Motes1 8:54a 428h

Tap to open a note or play a recording.

——— Tap and hold to display a pop-up menu of

\
on)) [[——— |«

New Tools @

actions.

Tap to record.

Tap to show or hide the Recording toolbar.

Tap to create a new item.
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To create a note:

Team meeting notes:

Adarn will send current status to core
team.

Julie will get the revenue numbers.
Tanner is back from the conference

and reports that the product was a
big hit!

Tap New.
Create your note by writing, drawing, typing, and recording. For more

information about using the input panel, writing and drawing on the
screen, and creating recordings, see Chapter 2.

oz 8:59 @ Tap to return to the note list (the note is saved
automatically).
Fe

12301[2]3]4[a][e]7[8]9]0]-[=]#

Tab[q[wle[r[t]y[u]iJo[p[L]]

caplafs|d[fla[h]jk[1]:]"]

shift] z [x [ c[¥ [ b

Tap to write on the screen.

PR R i

ctlai] - [\ ] [+ Tt]<]>
h Tap to show or hide the input panel.

New Edit Tools Q 7 @H

! Tap to add a recording to the note.

Inbox: Sending and Receiving E-mail Messages

Use Inbox to send and receive e-mail messages by synchronizing e-mail
messages with Microsoft Exchange or Microsoft Outlook on your PC.

Synchronizing E-mail Messages

E-mail messages can be synchronized as part of the general
synchronization process. You will need to enable Inbox synchronization in
ActiveSync. For information on enabling Inbox synchronization, see
ActiveSync Help on the PC.

During synchronization:

User's Manual

Messages are copied from the mail folders of Exchange or Outlook on
your desktop computer to the ActiveSync folder in Inbox on your
device. By default, you will receive messages from the past three days
only, the first 100 lines of each message, and file attachments of less
than 100 KB in size.

E-mail messages in the Outbox folder on your device are transferred
to Exchange or Outlook, and then sent from those programs.

E-mail messages in subfolders must be selected in ActiveSync on
your desktop computer in order to be transferred.
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Using the Message List

Messages you receive are displayed in the message list. By default, the
most recently received messages are displayed first in the list.
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Select the service and folder you want to display.

& Robert Brown S:45PM
RE: Today's Meeting

Received Date - |

Select the sort order for messages.

— Tap and hold to display a pop-up menu of
actions.

Tap to connect to the selected service.

& Jay Adams Mark as Unread
RE: Please "1 Move To...
&y Andrew Dixg
Status Repol
Bradley Bec =
& RE: LuT:uch Reply
(& Stuart Muns{ Reply Al
PocketPC Forward
& Linda Mitche
Remninder Delete ]
() Jeff Smith FTHSET T
RE: Working late
& Adam Barr 7i15PM 1K |
Don't Forget hd
Inbox: ActiveSync 11 Ikems.,
New Tools Services [1] E|A

——— Tap to connect and to send and receive e-mail.

When you receive a message, tap it to open it. Unread messages are

displayed in bold.

From: Robert Brown
Subject: RE: Today's Meeting
Sent: 4/23/01 5:45:47 AM

Just a rerminder to bring your individual
schiedules for the next 2 quarters with
you, We will be discussing projects and
timelines.

Thanks,
Bob

Tap to return to the message list.

Tap to delete this message.

Tap to reply or to forward this message.

Tap to view the previous or next message.

B

New Edit = = & P

E|A
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When you connect to your e-mail server or synchronize with your desktop
computer, by default, you’ll receive messages from the last five days only,
the first 100 lines of each new message, and file attachments of less than
100 KB in size. The original messages remain on the e-mail server or your
desktop computer.

You can mark the messages that you want to retrieve in full during your
next synchronization or e-mail server connection. In the message list, tap
and hold the message you want to retrieve. On the pop-up menu, tap
Mark for Download. The icons in the Inbox message list give you visual
indications of message status.

You specify your downloading preferences when you set up the service or

select your synchronization options. You can change them at any time:

B Change options for Inbox synchronization using ActiveSync options.

For more information, see ActiveSync Help.

B Change options for direct e-mail server connections in Inbox on your
device. Tap Tools and then tap Options. On the Service tab, tap the

service you want to change. Tap and hold the service and select
Delete to remove a service.

Composing Messages

User's Manual

To compose a message:
1 Tap New.

2 Inthe To field, enter an e-mail or SMS address of one or more
recipients, separating them with a semicolon, or select a name from
the contact list by tapping the Address Book button. All e-mail
addresses entered in the e-mail fields in Contacts appear in the
Address Book.

]
c
&f
£
W

i

Tap to show or hide the complete header.

Tap to send the message.

Tap to insert common message.

Tap to display the address book.

Tap to show/hide the recording toolbar.

—

New Edit My Text [[5] = E|*
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3 Compose your message. To enter preset or frequently used
messages, tap My Text and select a message.

4 Tap Send when you’ve finished the message. If you are working
offline, the message is moved to the Outbox folder and will be sent
the next time you connect. If you are working online, it is sent
immediately.

If you are sending an SMS message and want to know if it was received,
tap Edit, Options, and select Request SMS text message delivery
notification before sending the message.

Managing E-mail Messages and Folders

User's Manual

By default, messages are displayed in one of five folders for each service
you have created: Inbox, Deleted Items, Drafts, Outbox, and Sent ltems.
The Deleted ltems folder contains messages that have been deleted on
the device. The behavior of the Deleted and Sent ltems folders depends
on the options you have chosen. In the message list, tap Tools and then
Options. On the Message tab, select your options.

If you want to organize messages into additional folders, tap Tools, and
then Manage Folders to create new folders. To move a message to
another folder, in the message list, tap and hold the message and then
tap Move to on the pop-up menu.

Folder behavior with a direct connection to an e-mail
server

The behavior of the folders you create depends on whether you are using
ActiveSync, SMS, POPS3, or IMAP4.

B If you use ActiveSync, e-mail messages in the Inbox folder in Outlook
will automatically be synchronized with your device. You can select to
synchronize additional folders by designating them for ActiveSync.
The folders you create and the messages you move will then be
mirrored on the server. For example, if you move two messages from
the Inbox folder to a folder named Family, and you have designated
Family for synchronization, the server creates a copy of the Family
folder and copies the messages into that folder. You can then read the
messages while away from your desktop computer.

B If you use SMS, messages are stored in the Inbox folder.

B If you use POP3 and you move e-mail messages to a folder you
created, the link is broken between the messages on the device and
their copies on the mail server. The next time you connect, the mail
server will see that the messages are missing from the device Inbox
and delete them from the server. This prevents you from having
duplicate copies of a message, but it also means that you will no
longer have access to messages that you move to folders created
from anywhere except the device.
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B If you use IMAP4, the folders you create and the e-mail messages you
move are mirrored on the server. Therefore, messages are available to
you anytime you connect to your mail server, whether it is from your
device or desktop computer. This synchronization of folders occurs
whenever you connect to your mail server, create new folders, or
rename/ delete folders when connected.
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Chapter 5

Companion Programs

The companion programs consist of Microsoft® Pocket Word, Microsoft®
Pocket Excel, Windows Media™ Player, and Microsoft® Reader.

To switch to a companion program on your device, tap Programs on the
[&¥] menu, and then tap the program name.

Pocket Word

Pocket Word works with Microsoft Word on your desktop computer to
give you easy access to copies of your documents. You can create new
documents on your device, or you can copy documents from your
desktop computer to your device. Synchronize documents between your
desktop computer and your device so that you have the most up-to-date
content in both locations.

Use Pocket Word to create documents, such as letters, meeting minutes,
and trip reports. To create a new file, tap [, Programs, Pocket Word,
and then New. A blank document appears. Or, if you’ve selected a
template for new documents in the Options dialog box, that template
appears with appropriate text and formatting already provided. You can
open only one document at a time; when you open a second document,
you’ll be asked to save the first. You can save a document you create or
edit in a variety of formats, including Word (.doc), Pocket Word (.psw),
Rich Text Format (.rtf), and Plain Text (.txt).
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Companion Programs

Pocket Word contains a list of the files stored on your device. Tap a file in
the list to open it. To delete, make copies of, and send files, tap and hold
a file in the list. Then, select the appropriate action on the popup menu.

fg Pocket Word < 9:23 9
[E All Folders - Mame - Tap to change the sort order of the list.
] agenda 9:22 a 420b
_:i Docl .77 416D Select the type of folder you want displayed in the
i |Doc 22 a list.
@Meeting notes 927 a 428b
Create Copy 923 a 424b | Tap to open a document.
Delete
Select All

Tap and hold an item to display a pop-up menu of
actions.

Send via E-mail...
Beam File...

Rename,Move...

Tap to create a new document.

New Tools E|*

You can enter information in Pocket Word in one of four modes (typing,
writing, drawing, and recording), which are displayed on the View menu.

Each mode has its own toolbar, which you can show and hide by tapping
the Show/Hide Toolbar button on the command bar.

You can change the zoom magnification by tapping View and then Zoom.
Then select the percentage you want. Select a higher percentage to enter
text and a lower one to see more of your document.

If you’re opening a Word document created on a desktop computer,
select Wrap to Window on the View menu so that you can see the entire
document.
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Typing Mode
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Using the input panel, enter typed text into the document. For more
information on entering typed text, see Chapter 2.

To format existing text and to edit text, first select the text. You can select
text as you do in a Word document, using your stylus instead of the
mouse to drag through the text you want to select. You can search a
document to find text by tapping Edit and then Find/Replace.

Tap to return to the document (changes are saved
automatically).

Tap and hold to see a pop-up menu of actions.

Format...
Paragraph...

‘ p- E Tap to change formatting options.

]i_"E B I _SDIﬂ:heck = — | Tap to format text.
1231[2[3][4[5]6]7]8]9]0]- =]«
Tabla|wle[r[t[y[ufi]o[p|[]]
caPlals[d[f[o[h[ilk[I[;]"]
shitfz[x[c[v[b[nm][.[.[/]+

ctfai] " [\] Tap to show or hide the toolbar.

New Edit Yiew Tools |~
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Writing Mode
In writing mode, use your stylus to write directly on the screen. Ruled
lines are displayed as a guide, and the zoom magnification is greater than
in typing mode to allow you to write more easily. For more information on
writing and selecting writing, see Chapter 2.

jd'o
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£ |Pocket word o 1208 N

£ Elrlie]= -

N‘L:w Edit ¥iew Tools [

Companion Programs

With Space button selected, drag to insert space.
An arrow appears showing the space direction
and size.

Space button.

Tap to highlight selected text.

Pen button.

If you cross three ruled lines in a single stylus stroke, the writing becomes
a drawing, and can be edited and manipulated as described in the
following section.Written words are converted to graphics (metafiles)
when a Pocket Word document is converted to a Word document on your

desktop computer.
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Drawing Mode

In drawing mode, use your stylus to draw on the screen. Gridlines appear
as a guide. When you lift your stylus off the screen after the first stroke,
you’ll see a drawing box indicating the boundaries of the drawing. Every
subsequent stroke within or touching the drawing box becomes part of
the drawing. For more information on drawing and selecting drawings,
see Chapter 2.

4]

[ZIE]- L] 2] © &

New Edit Yiew Tools

E|A

Recording Mode

Companion Programs

Resize an object by dragging the selection
handles.

Tap an arrow to see your choices.

Tap to select formatting options, such as line
weight, fill colour, and line colour.

Pen button.

In recording mode, embed a recording into your document. Recordings
are saved as .wav files. For more information on recording, see Chapter 2.

For more information on using Pocket Word, tap ] and then Help.

User's Manual
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Pocket Excel
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Pocket Excel works with Microsoft Excel on your desktop computer to
give you easy access to copies of your workbooks. You can create new
workbooks on your device, or you can copy workbooks from your
desktop computer to your device. Synchronize workbooks between your
desktop computer and your device so that you have the most up-to-date
content in both locations.

Use Pocket Excel to create workbooks, such as expense reports and
mileage logs. To create a new file, tap , Programs, Pocket Excel, and
then New. A blank workbook appears. Or, if you’ve selected a template
for new workbooks in the Options dialog box, that template appears with
appropriate text and formatting already provided. You can open only one
workbook at a time; when you open a second workbook, you’ll be asked
to save the first. You can save a workbook you create or edit in a variety
of formats, including Pocket Excel (.pxl) and Excel (.xIs).

Pocket Excel contains a list of the files stored on your device. Tap a file in
the list to open it. To delete, make copies of, and send files, tap and hold
a file in the list. Then select the appropriate action from the pop-up menu.

Pocket Excel provides fundamental spreadsheet tools, such as formulas,
functions, sorting, and filtering. To display the toolbar, tap View and then
Toolbar.

Ey‘Pncket Excel o< 12:19 @

A3 =SUmMiaLA2) Cell contents appear here as you enter them.
A | B | c© [ H
|1 | $44.00 -
2 22,00 =
3 | $66.00)
|4 |
|5 | =
L Format button.
Al [» 11

[
Ready |Sheetl » ||Sum=4$66.00

F T | s 5 o E
1231 [2] s[e[7[a]o]o]-[=[«
Tab[a[wle[r [ty ulilo[p[L[[1]
CaPlafs[d[f]alh|i|k[I];]"]
shitfz[x[c[v[b[n[m][.[.[/]+
ctfaa " [\ ] [t]e]>
MNew Edit ¥iew Format Tools E \EH

Zoom button.

L i

M

- —

4
|

AutoSum button.

If your workbook contains sensitive information, you can protect it with a
password. To do so, open the workbook, tap Edit, and then Password.
Every time you open the workbook, you will need to enter the password,
S0 choose one that is easy for you to remember but hard for others to
guess.
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Tips for Working in Pocket Excel

Note the following when working in large worksheets in Pocket Excel:

B View in full-screen mode to see as much of your worksheet as
possible. Tap View and then Full Screen. To exit full-screen mode,
tap Restore.

B Show and hide window elements. Tap View and then tap the
elements you want to show or hide.

B Freeze panes on a worksheet. First select the cell where you want to
freeze panes. Tap View and then Freeze Panes. You might want to
freeze the top and leftmost panes in a worksheet to keep row and
column labels visible as you scroll through a sheet.

B Split panes to view different areas of a large worksheet. Tap View and
then Split. Then drag the split bar to where you want it. To remove the
split, tap View and then Remove Split.

B Show and hide rows and columns. To hide a hidden row or column,
select a cell in the row or column you want to hide. Then tap Format,
then Row or Column, and then Hide. To show a hidden row or
column, tap Tools, then Go To, and then type a reference that is in
the hidden row or column. Then tap Format, then Row or Column,
and then Unhide.

For more information on using Pocket Excel, tap [f] and then Help.

MSN Messenger

User's Manual

MSN®Messenger on your mobile device is an instant messaging program
that lets you:

B See whois online.
B Send and receive instant messages.
B Have instant message conversations with groups of contacts.

To use MSN Messenger, you must have a Microsoft Passport™ account
or a Microsoft Exchange e-mail account. You must have a Passport to
use MSN Messenger Service. If you have a Hotmail® or MSN account, you
already have a Passport. Once you have obtained either a Microsoft
Passport or a Microsoft Exchange account, you are ready to set up your
account.

Sign up for a Microsoft Passport account at http://www.passport.com.
Get a free Microsoft Hotmail e-mail address at http://www.hotmail.com.

To switch to MSN Messenger, tap [
Messenger.

, Programs, and then tap MSN
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Setting Up

i

Before you can connect, you must enter Passport or Exchange account
information.

To set up an account and sign in:

1 In the Tools menu, tap Options .

2 Inthe Accounts tab, enter your Passport or Exchange account
information.

3 To sign in, tap the sign-in screen and enter your e-mail address and
password.

If you already use MSN Messenger on your desktop computer, your
contacts will show up on your device without being added again.

Working with Contacts

|10
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The MSN Messenger window shows all of your messenger contacts at a
glance, divided into Online and Not Online categories. From this view,
while connected, you can chat, send ae-mail, block the contact from
chatting with you, or delete contacts from your list using the pop-up
menu.

.{f MSN Messenger £ 5:09 9

jh Kim Akers {(Online)

..jh Online
jh Adarn Barr
..jh Jo o
G‘fh Randall {Auweay)
i Mot Online
:"h Richard Bready
i David Hodgson

Tap a contact to start a chat.

Send Mail (Tim@woodgrovebank.c...
Block
Delete Contact

Tap and hold to see a pop-up menu of actions.

Properties

Tools Chats E|A

To see others online without being seen, in the Tools menu, tap My
Status and select Appear Offline.

If you block a contact, you will appear offline but will remain on the
blocked contact’s list. To unblock a contact, tap and hold the contact,
then tap Unblock on the pop-up menu.
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Chatting with Contacts

| [
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Tap a contact name to open a chat window. Enter your message in the
text entry area at the bottom of the screen, or tap My Text to enter a
preset message, and tap Send. To invite another contact to a multi-user
chat, in the Tools menu, tap Invite and tap the contact you want to invite.

.f.;g"MSN Messenger o 1:56 @

Enter message here.

hileazeuln=etatz u0g Send| Tap to send message.
123(1[2[3[4][5[6[7[8[o]o]-]=[w«
Tablg[wle[r[t]yuli[o[p[L[]
Caplafs[d[f[a[h[i[k[I[;["]
shift{ z[x[c[v[b[n[m][, [.[{]+
cuaia] " [\ ] [4]1 ][]+

Tools Chats My Text _'j. |4 |

To switch back to the main window without closing a chat, tap the
Contacts button. To revert back to your chat window, tap Chats and
select the person whom you were chatting with.
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To know if the contact you are chatting with is responding, look for the

message under the text entry area.

s 1:57

L.f.;g"MSN Messenger

Hi. Can you meet at 2:007

Jf &dam is typing a message.

123(1[2]3[4[s5][6]7]8[o]o]-[=[«
Tabja[wle[r[t[y[ufilo[p|[]]

caplals[d[f[a]n]ilk[1];:]"

I
shittfz[x[c[¥[b[n[m][,[.]/]+
cuaia] " [\ ] [4]1 ][]+

Tools Chats My Text _'j. B |~

View full chat.

View status of the chat.

For more information on using MSN Messenger, tap [ and then Help.
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Windows Media Player
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Use Microsoft Windows Media Player to play digital audio and video files
that are stored on your device or on a network. To switch to Windows
Media Player for Toshiba Pocket PC, tap , Programs, and then tap
Windows Media.

Ei windows Media 10:20a

YWelcome to Windows Media W - Microsc

£y

Windows

Media Player

Indicates the progress of the current track.

Tap to adjust volume.

ik Too

Tap to skip to the next track.

Tap to play a previous track.

Tap to stop.

Tap to play or pause.

Use Microsoft Windows Media Player on your desktop computer to copy
digital audio and video files to your Toshiba Pocket PC. You can play
Windows Media and MP3 files on your Toshiba Pocket PC.

For more information about using Windows Media Player for Toshiba
Pocket PC, tap EE], and then tap Help.
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Microsoft Reader

Use Microsoft Reader to read eBooks on your device. Download books to

your desktop computer from your favorite eBook Web site. Then, use

ActiveSync to copy the book files to your activated device. The books

appear in the Microsoft Reader Library, where you can tap them in the list

to open them.

Each book consists of a cover page, an optional table of contents, and

the pages of the book. You can:

B Page through the book by using the Up/Down control on your device
or by tapping the page number on each page.

B Annotate the book with highlighting, bookmarks, notes, and drawings.
B Search for text and look up definitions for words.

The Guidebook contains all the information you'll need to use the
software.

To open the Guidebook, tap Help on the Microsoft Reader command bar.
Or, on a book page, tap and hold on the book title, and then tap Help on
the pop-up menu.

To switch to Microsoft Reader, tap ], Programs, and then Microsoft
Reader.

Getting Books on Your Device
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You can download book files from the Web. Just visit your favorite eBook
retailer and follow the instructions to download the book files.

Sample books and a dictionary are also included in MSReader in the
Extras folder on the Toshiba Pocket PC Companion CD.

Use ActiveSync to download the files from your desktop computer to
your activated device as described in the Read Me file in the MSReader
folder.
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Using the Library

The Library is your MSReader home page; it displays a list of all books
stored on your device or storage card.

To open the Library:
B On the MSReader command bar, tap Library.

B On a book page, tap the book title, and then tap Library on the popup
menu.

To open a book, tap its title in the Library list.

d£2:46 €3

Page 1 Tap to scroll through
the Library list.

Microsoft® Reader Help

{Not yet spened) ———— Tap to open a book.

Tap to select a sort
order.

Tap to specify the -
books you want to
display in the list.

Tap to navigate to
other parts of the
reader.

Reading a Book
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Each book consists of a cover page, an optional table of contents, and
the actual pages of the book. Navigation options are listed in the bottom
portion of the cover page.

The first time you open a book, go to the first page or to the table of
contents, if there is one. Subsequently, whenever you open the book,
you’ll be automatically taken to the last page read.
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In addition to the text, each book page includes a page humber and book
title.

You can also page through a book by using the Up/Down control on your
device.

Lf:j' Microsoft Reader w250 €3

+ Microsoft® Reader Hel

Tap to select a navigation option.

Copying Text

You can copy tey—E ozl
into any prograr Add Bookmark

text. Add Highlight
To copy text Add Text Note

From & book pad Add Drawing

1. Select the te Find ..

copy by drag{Copy Text
across it

2. Tap [EoBRES from the

pop-up menu.

~ Drag to select text and then tap an option.

‘ T Tap arrows to turn the page, or tap and hold
4 gg 'k page # to bring up page riffle.

Using Reader Features
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Reading a book electronically gives you several options not available with
paper books. These options are available on any book page.

Select text by dragging across the text on the page. Then, tap an option
on the pop-up menu, as described here:

Search for Text: Find text in a book by tapping Find on the pop-up
menu. Enter the word you want to search for, and tap the desired Find
option. MSReader highlights the text on the page. To close Find , tap
outside the box. To return to your original page, tap the title and then
tap Return on the pop-up menu.

Copy Text: You can copy text from books that support this feature
into any program that accepts text. On a book page, select the text
you want to copy. Then, tap Copy Text on the pop-up menu. The text
can be pasted into the program of your choice.

Bookmarks: When you add a bookmark to a book, a color-coded
bookmark icon appears in the right margin. You can add multiple
bookmarks to a book. Then, from anywhere in the book, tap the
bookmark icon to go to the bookmarked page.

Highlights: When you highlight text, it appears with a colored
background.

Notes: When you attach a note to text, you enter the text in a note
pad that appears on top of the book page. A Note icon will display in
the left margin. To show or hide the note, tap the icon.
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B Drawings: When you add a drawing, a Drawing icon appears in the
bottom-left corner of the page, and drawing tools appear across the
bottom of the page. Draw by dragging your stylus.

B To see alist of a book’s annotations, including bookmarks, highlights,
text notes, and drawings, tap Annotations Index on the book’s cover
page. You can tap an entry in the list to go to the annotated page.

Removing a Book

User's Manual

When you finish reading a book, you can delete it to conserve space on
your device. If a copy of the book is stored on your desktop computer,
you can download it again at any time.

To remove a book from your device, tap and hold the title in the Library
list, and then tap Delete on the pop-up menu.
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Chapter 6

Pocket Internet Explorer

Use Microsoft® Pocket Internet Explorer to view Web or WAP pages in

either of these ways:

B During synchronization with your desktop computer, download your
favorite links and mobile favorites that are stored in the Mobile
Favorites subfolder in Internet Explorer on the desktop computer.

B Connect to an Internet service provider (ISP) or network and browse
the Web. To do this, you’ll need to create the connection first, as
described in Chapter 7.

When connected to an ISP or network, you can also download files and
programs from the Internet or intranet.

To switch to Pocket Internet Explorer, tap [i] and then Internet Explorer.

The Mobile Favorites Folder

Only items stored in the Mobile Favorites subfolder in the Favorites folder
in Internet Explorer on your desktop computer will be synchronized with
your device. This folder was created automatically when you installed
ActiveSync.

Favorite Links

During synchronization, the list of favorite links in the Mobile Favorites
folder on your desktop computer is synchronized with Pocket Internet
Explorer on your device. Both computers are updated with changes made
to either list each time you synchronize. Unless you mark the favorite link
as a mobile favorite, only the link will be downloaded to your device, and
you will need to connect to your ISP or network to view the content. For
more information on synchronization, see ActiveSync Help on the
desktop computer.
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Mobile Favorites

|10

If you are using Microsoft Internet Explorer 5.0 or later on your desktop
computer, you can download mobile favorites to your device.
Synchronizing mobile favorites downloads Web content to your device so
that you can view pages while you are disconnected from your ISP and
desktop computer.

Use the Internet Explorer plug-in installed with ActiveSync to create
mobile favorites quickly.

To create a mobile favorite:

1 In Internet Explorer on your desktop computer, click Tools and then
Create Mobile Favorite.

2 To change the link name, enter a new name in the Name box.
In Update, select a desired update schedule.

4 Click OK. Internet Explorer downloads the latest version of the page
to your desktop computer.

5 If you want to download the pages that are linked to the mobile
favorite you just created, in Internet Explorer on your PC, right-click
the mobile favorite and then click Properties. In the Download tab,
specify the number of links deep you want to download. To conserve
device memory, go only one level deep.

6 Synchronize your device and desktop computer. Mobile favorites that

are stored in the Mobile Favorites folder in Internet Explorer are
downloaded to your device.

(]

If you did not specify an update schedule in step 3, you will need to
manually download content to keep the information updated on your
desktop computer and device. Before synchronizing with your device, in
Internet Explorer on your desktop computer, click Tools and then
Synchronize. You will see the last time content was downloaded to the
desktop computer, and you can manually download content if needed.

You can add a button to the Internet Explorer toolbar for creating mobile
favorites. In Internet Explorer on your desktop computer, click View,
Toolbars, and then Customize.

To save device memory

User's Manual

Mobile favorites take up storage memory on your device. To minimize the
amount of memory used:

B In the settings for the Favorites information type in ActiveSync
options, turn off pictures and sounds, or stop some mobile favorites
from being downloaded to the device. For more information, see
ActiveSync Help.

B Limit the number of downloaded linked pages. In Internet Explorer on
the desktop computer, right-click the mobile favorite you want to
change and then Properties. In the Download tab, specify 0 or 1 for
the number of linked pages you want to download.
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Using AvantGo Channels

AvantGo is a free interactive service that gives you access to
personalized content and thousands of popular Web sites. You subscribe
to AvantGo channels directly from your device. Then, you synchronize
your device and desktop computer, or connect to the Internet to
download the content. For more information, visit the AvantGo Web site.

To sign up for AvantGo:
1 In ActiveSync options on the desktop computer, turn on
synchronization for the AvantGo information type.

2 In Pocket Internet Explorer on your device, tap the Favorites button to
display your list of favorites.

3 Tap the AvantGo Channels link.
Tap the Activate button.

5 Follow the directions on the screen. You will need to synchronize your
device with your desktop computer and then tap the My Channels
button to complete the AvantGo setup.

When synchronization is complete, tap the AvantGo Channels link in your

list of favorites to see a few of the most popular channels. To add or
remove channels, tap the Add or Remove link.

N

Using Pocket Internet Explorer

User's Manual

You can use Pocket Internet Explorer to browse mobile favorites and
channels that have been downloaded to your device without connecting
to the Internet. You can also connect to the Internet through an ISP or a
network connection and browse the Web.

.[f Internet Explorer oz 3146 9

Tap below for useful sites and services!
msn* Mobile
TOSHIBA

" PocketPC.com

d Avant Go™ Back button.

Refresh button.
‘ Home button.
‘ Favourites button.

= i = Hide pictures button.
¥iew Tools & @ﬂ o [F_j ’Q‘Iﬂ E|“
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To view mobile favorites and channels:

1 Tap the Favorites button to display your list of favorites.

Lff Internet Explorer £ 11:32 @

Favorites

3| Mobile Favorites
) svantGo Channels
1 Wacation web Sites
1 wiork web Sites
ﬁj Welcome to Microsoft's Homepage
] welcome to MSMN.com

Tap the favourite you want to view.

Open | Add | Delete l Tap to add or delete a folder or favourite link.

E|A

2 Tap the page you want to view.

You’ll see the page that was downloaded the last time you synchronized
with your desktop computer. If the page is not on your device, the favorite
will be dimmed. You will need to synchronize with your desktop computer
again to download the page to your device, or connect to the Internet to
view the page.

To browse the Internet:

1 Set up a connection to your ISP or corporate network using
Connections, as described in Chapter 7.

2 To connect and start browsing, do one of the following:

Tap the Favorites button, and then tap the favorite you want to
view.

Tap View and then Address Bar. In the address bar that appears
at the top of the screen, enter the Web address you want to visit
and then tap Go. Tap the arrow to choose from previously entered
addresses.

To add a favorite link while using the device, go to the page you want to
add, tap and hold on the page, and tap Add to Favorites.

i o
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Chapter 7

Getting Connected

You can use your device to exchange information with other mobile
devices as well as your desktop computer. You have the following
connection options:

B Use the infrared (IR) port on your device to send and receive files
between two devices. If this is the method you want to use, see the
following section “Transfer ltems Using Infrared.”

B Connect to your desktop computer to synchronize remotely. Once
connected, you can synchronize information such as your Pocket
Outlook information. If this is the method you want to use, see
ActiveSync Help on your desktop computer or Connections Help on
the device.

Transfer Items Using Infrared

Using infrared (IR), you can send and receive information, such as
contacts and appointments, between two devices.

To send information:
1 Switch to the program where you created the item you want to send
and locate the item in the list.

2 Align the IR ports so that they are unobstructed and within a close
range.

3 Tap and hold the item, and tap Beam Item on the pop-up menu.

You can also send items, but not folders, from File Explorer. Tap and hold
the item you want to send, and then tap Beam File on the pop-up menu.

|10

To receive information:
1 Align the IR ports so that they are unobstructed and within a close
range.

2 Have the owner of the other device send the information to you. Your
device will automatically receive it.
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Getting Connected

Get Help on Connecting
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More information on the procedures described here, as well as
information on additional procedures, can be found in the following
locations:

Inbox: Sending and Receiving E-mail Messages in Chapter 4.

Online Help on the Pocket PC. Tap [] and then Help. Tap View, All
Installed Help, and then Inbox or Connections.

ActiveSync Help on the desktop computer. In ActiveSync, click
Microsoft ActiveSync Help on the Help menu.

For troubleshooting information, see the PocketPC Web site at:
http://www.microsoft.com/mobile/pocketpc.
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Chapter 8

Optional Functions

Home

You can launch the built-in or installed applications easily by tapping the
icon displayed on the Home screen. You can also set to display a desired
bitmap image on your screen background.

Launching an Application From the Home

1 Tap &, Programs, and then Home to display the Home screen.

You can also launch the Home by pressing the Toshiba Pocket PC
Home button.

For initial setting, the respective
application icons are registered on
three tabs: Main, Programs and
Games. In the Running tab,
active applications are displayed.

Tabs.

[Ruﬁning | [LET] |F‘rc:grams lGames J

T Tap to select Tab Settings... or About.

Edit ¥iew Tools E! - N Tap to select Large Icon, Small Icon or
i . Text color...

L Tap to select Paste or Add.

2 Tap the desired tab, and then tap the application icon you want to
launch. The selected application starts up.
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Also, you can launch an application by moving the cursor button or
scroller to select and pressing the center of the cursor button to confirm.

You can add tabs up to a maximum of 10 kinds and icons up to 18 in a
tab.

About Running

User's Manual

In the Running tab, the active application names are displayed.
The icons do not appear.

Application Activate/Stop:

Tap the application name you want to activate. You can also activate the
application from the pop-up menu displayed by tapping and holding the
application name.

Tap to activate the selected application.

Tap to quit the selected application. When
finished, the applicatin name disappears.

Tap to quit all running applications displayed in
the Running tab.

You can select the View menu or the Tools menu
on the Running tab screen. You can select Text
color... from the View menu, the Tab Settings...
or About from the Tools menu respectively.

RUnning | [Main l Programs l 53armes J

Yiew Tools E|*

You can show a pop-up menu by tapping and holding any portion other
than the application names displayed in the Running tab. In this case,
only the Stop All is selectable.
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Display Icon List

The following list shows the tabs and icons for the initial setup.

Tabs Icons Applications
Running - -
Main @ Pocket Internet Explorer
@ Windows Media Player
Notes
Tasks
E Inbox
E Calendar
Contacts
W Pocket Word
Pocket Excel
B Calculator
Programs gd File Explorer
E{]JE Backup
”@ Infrared Receive
Games Solitaire

()

Moving an Application Icon into Another Tab
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The moved icon is placed next to the last icon on the tab screen. You
cannot move an icon into a tab which already contains 18 icons.

To move using pop-up menu:

1 Tap and hold the icon you want to move to display the pop-up menu.
2 Tap Cut on the pop-up menu.

3 Tap the destination tab, and then tap Paste on Edit menu. The
selected icon is pasted on the screen.

You can also select Paste from the pop-up menu displayed by tapping
and holding any portion other than the icon.
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Deleting an Icon

1
2

Tap and hold the icon you want to delete to display the pop-up menu.

Tap Drop on the pop-up menu. The icon is deleted and the next icon
positioned after the deleted icon automatically shifts to fill the deleted
icon position. And all icons after the deleted icon likewise shift to fill
the previous icon position.

Adding an Icon

You can add the application and your file icons to the Home screen.

| [
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1

2

Tap Edit and then Add to display the Add Application screen.

You can also select Add from the pop-up menu displayed by tapping
and holding any portion other than the icon.

Tap ¥ of Application file to show the file list. If there is no desired file
on the file list, you can find it by tapping Browse. To refer to all folders
and files, tap Browse to show the Browse Dialog screen. When the
file is selected, its name is displayed in the Application file box.

— Tap to designate a folder you want to browse.

When a storage card is inserted, files or folders
contained in the storage card are displayed from

the top directory.
Erowse
Folder: | e Tap to move up to a directory folder one level
above the currently displayed one.
Type :|Executable files(*.exe) vJ»T
ame | Date - L Tap to select kinds of application or file to be
= b d.
[ addrbook exe 07/27/2001 4= rowse
Backlight e 09132001 4
B backup.exe 097132001 4
calc.exe O5/21f2001 If a file is selected from the list, the screen returns
E calendar, exe U?IE?IEUDI 7 to the Add Applicatin screen.
F calnot.exa 07/27/2001 3
F dock.exa 06/21/2001 |1+
<] ] | [»
|-

3 Enter an icon name in the Application name box, which is to be

displayed on the Home screen.
You can enter up to a maximum of 32 characters.

4 When finished, tap OK to close the Add Application screen, and the

new icon is added to the Home screen.

If the Application file is not designated, or if the Application name is not
entered, you cannot add a new icon.

You cannot launch the icon added from the storage card, if the same card
is not inserted in the Toshiba Pocket PC.
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Tab Setting

You can set to add, delete or rename the tab on the Tab Settings screen.
You can also set to display a desired bitmap image on your screen
background.

To add a tab:

1 Tap Tools and then Tab Settings to display the Tab Settings screen.

2 Tap Tab Settings and then New to display a box to enter the new tab
name.

3 Enter a new tab name. When finished, tap OK to return to the Tab
Settings screen. You can enter up to a maximum of 10 characters.

4 Tap OK on the Tab Settings screen to return to the Home screen.

To delete a tab:

1 Tap Tools and then Tab Settings.

2 Select the tab name to delete, and then tap Delete, the Delete tab
dialog for confirming appears. Please note that all the icons contained
in the same tab will also be deleted.

3 Tap OK on the Delete tab dialog to delete the tab. When finished, the
screen returns to Tab Settings screen.

4 Tap OK on the Tab Settings screen to return to the Home screen.

You cannot delete the Running tab.

jd'o

To change the name of a tab:

1 Tap Tools and then Tab Settings to display the Tab Settings screen.
2 Select the tab name you want to change, and then tap Rename.

3 Enter a new tab name. When finished, tap OK to return to the Tab
Settings screen. You can enter up to a maximum of 10 characters.

4 Tap OK on the Tab Settings screen to return to the Home screen.

You cannot rename the Running tab.

jud'o
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To change a background:

i

1 Tap Tools and then Tab Settings to display the Tab Settings screen.
2 Select the tab of which background you want to change.

3 Tap Browse to display the Browse dialog screen.
4

Tap the desired bitmap file from the list to return to the Tab Settings
screen.

5 Tap OK on the Tab Settings screen to return to the Home screen.

If the selected file is not a bitmap file, you cannot set it on your screen
background. The displayable range of the bitmap image on the Home
screen is 240(W) x 246(H).

Text Color Setting:

You can set the color of application name for each tab using Text Color.

1 Tap the tab whose color you want to set to display the selected tab
screen.

2 Tap View and then Text Color to display the color list.
You can set the color of the application name as desired.

3 Tap the color you want to set, and the color of the application name
changes.

Home Help

Tapping an icon displayed at “Home” launches that application. In
addition to applications, it is also possible to register icons forassociated
files here. The Home screen is divided into tabs. There are 4 tab types as
default, and up to 10 types of tab can be registered. As for the icons on
the tab, up to 18 icons per one tab can be registered.

A bitmap image can be used as the background for the tab screen.

(1).“Running” tab
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The names of currently running applications are displayed at the

“Running” tab.

Applications can be switched or quit here.

“Text Color” can be selected from the “View” menu, and “Tab Settings”

and “About” can be selected from the “Tools” menu.

B To activate applications, tap and hold the name of the application you
want to activate to, then tap “Activate” from the pop-up menu.

B To stop an application, tap and hold the name of the application
youwant to stop, then choose “Stop” from the pop-up menu. If “Stop
all” isselected from the pop-up menu, all currently running
applications arestop.

B “Stop all” can also be selected by tapping and holding on the
“Running” tab screen without selecting an application name.
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(2).Launching applications

When an icon on the tab screen is tapped, the application or associated
file registered at the icon is launched.

B Applications can also be launched by selecting them with the cursor

button then pressing on the center of the cursor button.

(3).Switching the icon display

Tap on the “View” menu to display the current display settings.
Currentdisplay settings are indicated by check mark at the left. To switch
the display, select “Large Icon” or “Small Icon”.

(4).Icon settings

User's Manual

1.

1
2
3

—h

Moving icons (using the pop-up menu)
Tap and hold the icon you want to move on the tab screen.

When the pop-up menu appears, select “Cut” from the menu.

Tap on the tab to which you want to move the icon, then tap
“Paste”from the “Edit” menu to move the icon and display it on the
tab screen.

“Paste” can also be selected from the pop-up menu displayed when
you tap and hold at a position on the screen other than on icon.

It is not possible to move icons to tabs already containing 18 icons.
When an icon is moved, it is positioned at the very end of the tab’s
icons.

Deleting icons

Tap and hold the icon you want to delete. A pop-up menu appears.

Tap “Drop” from the pop-up menu to delete the selected icon from
the tab screen.

When an icon is deleted, subsequent icons are all moved up one
place.
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Adding icons

Tap the tab to which you want to add an icon to select that tab.

Tap “Add” from the “Edit” menu to display the “Add Application”
screen.

Tap the “Application file” box.

From the list, tap the application you want to add. To select a file not
on the list, tap the “Browse” button, then select the file from the
Browse Dialog.

Input the name of the icon you want to add (up to 32 characters) in the
“Application name” box.

Tap the “OK” button. The new icon is added.
Associated files can be specified for added icons.

If either one of “Application file” or “Application name” is not filled in,
an icon can not be added.

. Browse Dialog

Tap the “Folder” box to select the folder to be browsed.
Tap the “Type” box to select the type of file to be browsed.

The list of the files of the specified type and in the specified folder
appears on the screen. Select the desired application or file or the
bitmap image to be used as the background and tap it. The original
screen reappears.

If a storage card is inserted into the main unit when adding icons,
icons of applications and files on the storage card are also displayed
on the browse screen. The folders and files on the storage card can
be displayed in the “Folder” box, beginning at the topmost level.

If an icon on a storage card is added, that storage card must be
inserted when the icon is tapped or the file will not be launched.

(5).Tab settings
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1. Switching tabs

Tap on another tab to switch the tab screen.

Initially four tabs are registered: “Running”, “Main”, “Programs” and
“Games”.

2. Changing tab names

1

Select “Tab Settings” from the “Tools” menu. The “Tab Settings”
screen appears.

Tap the “Select tab” box to select the tab to be changed.

Tap the “Rename” button. The screen for inputting the new tab name
appears.

Input the new tab name (up to 10 characters) into the “Rename to”
box.
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Tap the “OK” button. The tab name is changed and the “Tab
Settings”screen reappears.
Tap “OK” at the upper right to return to the Home screen.
Deleting tabs
Select “Tab Settings” from the “Tools” menu. The “Tab Settings”
screen appears.
Tap the “Select tab” box to select the tab to be deleted.
Tap the “Delete” button. A dialog asking you to confirm you want to
delete the tab appears.
Tap the “Yes” button. The tab is deleted and the “Tab Settings”
screen reappears.
Tap “OK” at the upper right to return to the Home screen.
Note that when a tab is deleted, all the icons on that tab are also
deleted.
“Delete” cannot be selected if there are only two tabs on the Home
screen.

. Adding tabs
Select “Tab Settings” from the “Tools” menu. The “Tab Settings”
screen appears.
Tap the “New” button. An input screen appears.
Input the name you want to give the tab (up to 10 characters) into the
“New tab” box.
Tap the “OK” button. The new tab is added and the “Tab Settings”
screen reappears.
Tap “OK” at the upper right to return to the Home screen.

. Setting the background bitmap

Select “Tab Settings” from the “Tools” menu. The “Tab Settings”
screen appears.

Select the tab whose background you want to set at the “Select tab”
box.

Tap the “Browse” button to display the Browse Dialog.

Select and tap the bitmap image to be used as the background. The
“Tab Settings” screen reappears.

Tap “OK” at the upper right to return to the Home screen.

Setting the text color

Different colors can be set for the application names at the different tabs.

1

2

Display the tab whose color you want to set, then select “Text
Color’from the “View” menu.

Tap the color you want to set from the list of display colors. That color
is set for the application names.
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How to Make a Backup

You can make a backup of the Toshiba Pocket PC data to a SD Memory
Card. If you have backed up your data on a SD Memory card, you can
restore that data in your Toshiba Pocket PC. You can also delete backup
file data from the SD Memory card. Periodical data backup is
recommended.

Data of the following three types can be backed up:

File: Includes a file created by Pocket Word, Pocket Excel, Notes, etc. or
an additionally installed program and so on.

Registry: Setting information on Windows CE or Built-in Program.
Database: Database information of Microsoft Pocket Outlook.

If you update ROM programs using special installation programs with a
* Xip extension, do not use the backup data which you made before
updating ROM programs.

When using the Databackup, beware of the remaining battery charge.

i o
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Making a Backup
1 Insert an SD Memory Card.
2 Tap Start, Programs, and then DataBackup to display the
DataBackup screen.
3 Set a Custom Name, if you want.
Tap Backup to display the Prompt message screen.

5 Tap OK. The Proceeding message is displayed during the backup
process. When the backup is completed, a backup finished message

appears.
6 Tap OK to return to the previous screen.

N

.f;:i‘ DataBackup

Custom Mame |Ela|:km |

[ voice Recorder 4.24 KB
[ IMotes .60 KB
Tasks 0.27 KB
[ Iz 216 KB
[P=lContacts 0.52 KB
ElCalendar 0.27 KB
Datahases 23.68 KB
Program Files 3325.52 KB
| ToTaL sI7E 3365.24 KB |

S0 CARD FREE SIZE 3245 MB

[Backup | | 50

Brackup | Restore |
About E|*

If the SD Memory card does not have enough free capacity, the backup
process stops. Check the storage capacity before starting the backup.

If the SD Memory card is write protected, you cannot save the backup
data. Cancel the write protection before starting the backup.

|10
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Carrying Out Restore Operation

To restore is to overwrite the backed up data from the SD Memory card
onto the main memory of your Toshiba Pocket PC. If the same file name
exists in the main memory of your Toshiba Pocket PC, the file data is

replaced with the backup data from the SD Memory card. If files exist in
the main memory but not in the backup file, they will not be overwritten.

1 Insert the SD Memory card, which contains backup data into your
Toshiba Pocket PC.

2 Tap Start, Programs, and then DataBackup to display the
DataBackup screen.

3 Select Restore from tab.

4 Select backup file from restored files list.

5 Tap Delete if want to delete backup file.

6 Tap Refresh if want to refresh Storage Card.

7 Tap Restore to display the Prompt message screen.
8

Tap OK. The Proceeding message is displayed during the restore
process.

When the restore is completed, a restore finished message appears.
9 Tap OK. Your Toshiba Pocket PC is reset and restarts automatically.

.f;:i‘ DataBackup

Restored Files:

[-Jarme | Size

24.19 KB

I Backup1.dok 24.19 KB
| Delete | 1 Refresh |

[Restore | | 50%
Backup | Restore |

About E|A
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Data Backup Help

The backup function allows you to back up the data from the main unit on
storage cards. The backed up data can be restored and deleted.

Before performing the backup or restore operation, check that there is
enough space in the main unit’s memory and on the storage card.

(1).Loading the storage card
B Make sure the main unit’s power is off when loading and unloading
the storage card.

B Insert the storage card in the designated card slot, making sure to do
so in the proper direction.

B Save current data in the main unit’s memory before backing it up on
the storage card.

(2).Making backups

1 Select “DataBackup” from “Programs” in the “Start” menu.
Once the backup screen appears, tap the “Backup” tab.
Set a Custom Name if you want.
Tap the “Backup” button.
A message appears once backing up is completed.
Tap “OK” at the upper right to return to the previous screen.

oG OODN

(3).Restoring the data

Use this operation to restore the backup data stored on the storage card
into the main unit. The data in the backup file is copied over the data in
the main unit’s memory.

B If a file with the same name already exists in the main unit’s memory,
its data is replaced with the data in the backup file.

B Files in the main unit’s memory not included in the backup file remain
in the main unit’s memory.

Select “DataBackup” from “Programs” in the “Start” menu.
Once the backup screen appears, tap the “Restore” tab.
Select a backup file from the Restored Files list.

Tap the “Restore” button.

A message appears once the restore operation is completed.
Tap “OK” button. The main unit is reset and restarted.

o b ODN =

User's Manual 8-13



Optional Functions

(4).Deleting a backup file

Select “DataBackup” from “Programs” in the “Start” menu.
Once the backup screen appears, tap the “Restore” tab.
Select a backup file from the Restored Files list.

Tap the “Delete” button. A message screen asking you to confirm that
you want to delete the backup file appears.

5 Tap the “OK” button.

The backup data is deleted from the storage card and the previous
screen reappears.

A ODN =
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TOSHIBA Pocket PC e310

Chapter 9

Additional Information

Troubleshooting

Check the following guide for the possible cause of a problem and how to
correct it.

Symptom Cause Correction

The power button is The built-in battery power is Charge the battery.
pressed but the power does exhausted.

not turn on.

The power was suddenly The built-in battery power is Charge the battery.

cut off. exhausted.
Automatic suspend is Select [, Settings,
active. System, Power to set to
alter the power shut down
time.
Even if the built-in battery is The built in battery is Replace the main battery
completely charged, it extinct. with a new one.

discharges after a short
period of time.

The screen was tapped, but Touch screen adjustment is Select [, Settings,

no correct action was not  incorrect. System, Align Screen to

executed. adjust the touch screen. If
the screen alignment loses
calibration it may not be
possible to adjust alignment
using the above method. In
that case, the Align Screen
command can be executed
by simultaneously pressing
the power button and scroll
button.
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Symptom

The screen was tapped, but
there is no response. The
operation button does not
work either.

The screen is dark.

The screen is hard to see.

Can not connect to your
computer.

ActiveSync does not
function when your
Pocket PC is connected to
your computer with a USB
cradle or USB cable.

User's Manual

Cause

Unresponsive operating
system

The front light is off.

Brightness setting is
incorrect.

“USB SETUP TOOL” was
not executed. It should be
performed after execution
of ActiveSync.

The USB driver of your
computer may not be
compatible.

Additional Information

Correction

Reset the system. If no
action is observed after
resetting the system,
initialize the system. (NOTE:
YOUR DATA WILL BE
DELETED.)

Press and hold the power
button until the front light is
turned on or touch the
screen with the stylus.

Select [, Settings,
System, Front Light to

adjust the screen brightness
for better sight.

See Help of ActiveSync.

Install “USB SETUP TOOL”
contained in the Companion
CD.

Reselect the USB driver.
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Resetting

i o

Reset is equal to "Restart" of a computer. Carry out when a button or
tapping the screen does not respond. When your Toshiba Pocket PC is
reset, all data that was not stored during operation will be deleted. Stored
data will be saved.

If the function cannot be restored even if the reset button is pressed,
initialize your Toshiba Pocket PC.

B When the power is on, press the reset button with the stylus, then
release.

Initializing

| [

User's Manual

When you initialize your Toshiba Pocket PC, it returns to the status when
it was purchased.

When you initialize your Pocket PC, all data stored in the memory
isdeleted. Your Pocket PC’s initially installed programs are not deleted.

Before initialization, remove all storage cards.

1 Turn off the power.

2 Press the power button while pressing and holding the reset switch
with the stylus, and then release the power button.

3 When a screen appears, release the reset switch. When initialization is
completed, the Welcome screen appears. Set up the system
according to the screen as in the case of startup procedure.
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External dimensions
Weight

Operating conditions

Built-in battery

Type
Continuous
operating time

Memory keeping
time

Processor
Action clock
Memory
Display

Additional Information

78.75mm(W) x 15.25mm(D) x 124.5mm(H)

1429 (502)

Temperature: 0°C to 40°C, Humidity: 30 to 80%
RH, when only the Pocket PC is operating
Temperature capable of charging: 5°C to 35°C

Advanced Lithium lon battery
Approx. 10 hours.

For continuous indication of the Today screen,
front light: OFF, ambient temperature: 25°C

Approx. 72 hours.

If left at ambient temperature of 25°C after the
power has become unable to turn on

Note: Continuing operating time and memory
keeping time vary according to the charging
condition, ambient temperature, operating
condition, etc.

Strong ARM SA-1110
206MHz
32MB SDRAM

Reflection color TFT, 240x320 pixels, up to 64K
colors
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Interfaces
SD card slot

Infrared port

Stereo headphone
jack

Cradle connection
port

DC-IN Socket

AC adaptor

Additional Information

SD memory card or SDI/O card

Note: The security function of the SD memory
card is not usable. Data encrypted by the SD
memory card security function-compatible
equipment is not usable.

Based on IrDA Ver.1.3
Maximum data transmission speed: 115 kbps

23.5mm, stereo mini plug compatible

Input power supply: 100-240VAC, 50/60Hz,
33VA

Rated output: DC 5V, 2A

Although the display is manufactured using an extremely high order of
technology, there may be a case that some dots do not light or always
light. It is not a malfunction.
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